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Welcome to WindO/I-NV4!
Thank you for purchasing the "WindO/I-NV4".

The WindO/I-NV4 is software for the main unit (operator interface). WindO/I-NV4 can be
used to create screens or program operations for the main unit. To set up main unit screens
and operations, you must first create a project, then set up the devices and working
environment. Next, place the parts like switches and displays on the screen to prepare for
the operations. Finally, download the created project to the main unit to construct the
operating environment.

Highlights of WindO/I-NV4 are as follows.

Easy-to-use workspace

The project's structure is clear at a first glance. Switching to editing could be done in a one-
click manner. The WindO/I-NV4 provides you with an efficient working environment and a
high degree of freedom for creating screens.

Managing text data collectively with the text manager function

You can collectively manage the text used in the switch and lamp names and the alarm
function. Text settings (font, text, text color, size, etc.) can be exported to a CSV format file,
and by importing the file after editing with general-purpose software such as Excel. This
management functionality helps the user to achieve efficient editing of the project.

Easy setup of parts' trigger conditions

The trigger conditions of switches and lamps, bit/word write, and goto screen commands can
be set easily in the properties of each part. The status (OFF — ON - OFF) of the lamp can be
set with ease as well.

Reuse of data

Screen data and scripts from different projects can be reused, making effective use of
software assets. Image data in BMP, JPG, WMF, and ICO file formats are also reusable.

Tag Editor's Cross Reference function provides ease of access to the used
device

The Tag Editor, which is the same GUI as WindO/I-NV3 and WindLDR, can be shared and used,
making it easy to check the device addresses used in the project and replace the device
addresses.



Notes - WindO/I-NV4

There are the following notes for using WindO/I-NV4. Thank you for your understanding.

Text and Fonts

)
2)

3)

For character input such as a "Registration Text" or a "Message Display", which has
character restrictions, a carriage return is equivalent to two characters.

The font, line, and resized image of the bitmap displayed on WindO/I-NV4 may appear
differently on the main unit. So please check the appearance of the main unit.

If the DPI setting in Windows is greater than 100%, the dialog box may not be displayed
properly. To display dialog properly, please set DPI setting to 100%.

Edit

)

2)

3)

4

WindO/I-NV4 does not have a limitation for the number of editing windows which can be
opened at the same time. The limitation depends on the RAM of the PC. If the editing
window cannot be opened, then the warning message is displayed

If you want to input languages like Chinese or Korean on English OS, then please check
the input procedure and notes on the manual and help.

Assume the "Fill" drawing is used in the NV Metafile and that NV Metafile is used in the
image of the drawing or part object. If the user attempts to resize the placed object, then
the "Fill" may leak over the designated area and may change the displayed image.

If "None", "Fore 100%", "Back 100%" or gradation pattern is not selected as Patterns in
the property of the object, such as drawing and part, and "Place on the Top Layer" is ON,
then the pattern is started from the left top side of the objects. If "Place on the Top
Layer" is OFF, the pattern is started from the left top side of the screen.

Communication

)
2)
3)

4)

3)

The screen monitor may not update the value of the external device address set for write
only. Please use Custom Monitor or Batch Monitor to monitor the device instead.

Do not write 16bit data or bit data to the 32bit device using the Emerson ROC Protocol

driver.

Do not send more than one command at the same time if Ethernet is selected for the

User Communication Interface.

The following points should be taken into consideration when "Automatically obtain the

IP address" is selected.

- It may take some time to obtain the IP address, and a communication error may
occur. If a communication error occurs, then please download the project again.

- Whenever downloading the project data, the MICTO/I obtain an IP address.
Therefore an IP address may change.

- While using the Monitor function, download the project after stopping the Monitor
function.

When using the Modbus RTU Slave driver with the connection of 1:N, the Modbus RTU
Master side must take into account the idle time* of 4.0 characters or more to the



transmission wait time. (FT21/1], HG2]/1] only)
(*Reference value: When Baud Rate is 9600bps, idle time is approximately 5.0
milliseconds)

6) For models where project data created with the new WindO/I-NV4 has been downloaded,
it is not possible to upload the project data to a PC using an older version of WindO/I-
NV4 (the upload may stop, or the project may not open and saved after the upload).
Please use the same version of WindO/I-NV4 as the one used by the target model for
uploading.

Touch Panel

When more than one spot is pressed at the same time, due to the detection characteristics
of an analog-type touch panel, the center part of a pressed spot is registered and the
operator interface assumes that only one spot is pressed. Thus, please avoid pressing
multiple spots of the touch panel at the same time.

External Memory Device

If a FAT32 format USB memory is connected while running, the main unit scan time becomes
temporarily longer by reading the information from the USB memory. (FT2J/1], HG2]/1]
only)

When the SNTP and Time Zone functions are enabled, the modified date may shift when
writing folders and files to the external memory device. (FT21/1], HG2]/1] only)

Compatibility of WindO/I-NV2

The project file, which is created by WindO/I-NV2, can be opened by WindO/I-NV4. However,
the project file should satisfy the following conditions.
- The project file is saved by WindO/I-NV2 Ver.4.80 or the newer version

- HG4G/3G(Multimedia), HG4G/3G, HG2G-5F, HG2G-S/2G-5S, or HG2G-S/2G-
5S(Ethernet) are selected for the Product Series

If the following conditions are satisfied and drawing objects or part objects are overlapped

on overlay screens, the display order of those objects may differ from that of WindO/I-NV2.
To circumvent, enable the "Place on the Top Layer" check box in the property dialog box of
those drawing objects or part objects.

- HGA4G/3G(Multimedia), HG4G/3G, or HG2G-5F are selected as Product Series in the
project
- An overlay screen is used
Compatibility of WindO/I-NV3

The project file, which is created by WindO/I-NV3, can be opened by WindO/I-NV4. However,
the project file should satisfy the following conditions.

- The project file is saved by WindO/I-NV3 Ver.5.00 or the newer version



About WindO/I-NV4 version of HG3G-V8
Please use WindO/I-NV4 V2.0.1 or later version for HG3G-V8 shipped after May 2022.

When downloading a project using WindO/I-NV4 V2.0.0 or earlier, the following screen may
appear during download.




WindO/I-NV4 Ver.3.4.0

<Runtime System Software>

The following functions have been introduced.

4
4

QR Code Display is added. (Only for FT21/1] models and HG21/1] models)

The main unit can now be operated with a USB mouse. (FT2]/1] models, HG2]/1]
models, HG5G/4G/3G/2G-V models)

MQTT communication supports connection with Sparkplug B. (Only for FT2]/1] models
and HG2J/1] models)

When used as an EtherNet/IP scanner, error status is stored in the control register. (Only
for FT21/1] models and HG2]/1] models)

When used as an EtherNet/IP scanner, communication size can be specified in bytes.
(Only for FT23/1] models and HG23/1J models)

When used as an EtherNet/IP scanner, Real Time Format can be specified. (Only for
FT23/1] models and HG2]/1J models)

In the "Project Settings" dialog box, under the "Compatibility" tab, you can select the FTP
server behavior "After creating a subfolder, transfer the files to the subfolder directory".
(HG5G/4G/3G/2G-V models, HG4G/3G/2G-5F models, HG2G-5T models, HG1G/1P
models)

<Application Software>

The following functions have been introduced.

4
4

The settings for new features of the System Software are added.
In the FT2]/1] type project, displaying the range of device addresses occupied by control
devices was supported.

Error checking for invalid values in IP addresses, subnet masks, and default gateways
has been improved.

Bugs Fixed

The following problems have been fixed:

4

4

If the "Use Security Features" checkbox is turned ON and a project file created with
WindO/I-NV4 Ver.3.2.0 or later is uploaded, WindO/I-NV4 may freeze.

In EtherNet/IP Settings dialog box, importing EDS or opening Configuration Data Dialog
box may fail dependent on contents of the EDS file.

If you delete an email address that was registered before the email address set in the
email group in the Email Address Book dialog and then save the project, the numbers
assigned to the addresses in the email become incorrect.

When a project created in WindO/I-NV4 Ver.2.2.0 or earlier with a line graph, a multi-
command without any command set, and a key button placed in that order on the same
screen is upgraded to Ver.2.3.0, the key button is incorrectly changed to a word button.



<Web Page Editor>
The following functions have been introduced.

» WindO/I-NV4 now supports Web Page Editor Ver.3.7.7. Please check the revision history
of Web Page Editor help for detail.



WindO/I-NV4 Ver.3.3.0

<Runtime System Software>

The following functions have been introduced.

» A glove mode has been added to make touch panel operation feel lighter.

(Only for FT23/1] models and HG2J/1] models)

Bugs Fixed

The following problems have been fixed:

»

When reading from or writing to a connected device, the screen may not update, and
parts placed on the screen may become unresponsive. (Only for FT2]/1] models and
HG2]/1] models)

If the project data size is approximately 19MB or more, the simulator cannot start. (Only

for FT21/1] models and HG21/1] models)

In Files Copy function, if folders or files exist in the 5th level of the source folder, the file

copy may fail or the main unit may restart.

If you remove the external memory without stopping access while a communication error

message is displayed, the bottom part of the message window will be cut off.

If an invalid JPEG format image file is stored on external memory and attempted to be

displayed on the main unit, the main unit may restart. (Only for FT2J/1J models and

HG2]/1] models)

If all of the following conditions are met, the display on the main unit during transfer will

be distorted.

- Downloading a project to a main unit set in a vertical orientation.

- Downloading a project using the USB Autorun function, Key Buttons, Multi-Buttons, or
Multi-Commands.

- The version of the system software currently running differs from the version of the
system software included in the project to be downloaded.

(HG5G/4G/3G/2G-V models, HG4G/3G/2G-5F models, HG2G-5T models, HG1G/1P
models)

The following bugs fixed in WindO/I-NV4 Ver.3.0.1 reappear in Ver.3.1.0 and Ver.3.2.0.

(Only for FT23/1] models and HG2]/1J models)

- In the Email Function, when attaching a log data file by setting "Specify a period of
time", the log data for the specified period may not be attached.

- In the Email function, if special characters are included in "Sender Name", "To", "Cc",
or "Bec", sending an e-mail may result in a timeout error or authentication error
instead of a parameter error.

- When 32,767 characters or more are set on the "Message" tab of the Message
Switching Display without using the Text Manager, messages after the 32,768th
character are not displayed correctly.



<Application Software>

The following functions have been introduced.

4
4

4

The settings for new features of the System Software are added.

When converting the model of an FT1A Touch project, the cartridge control devices I
(input) and Q (output) set in the project are automatically reassigned.

Monitor can still be performed even when the project file's last updated timestamp differs
between the display and WindO/I-NV4.

An error check is performed to check whether the IP address, Subnet mask, and default
Dateway under the "IP Settings" on the "Communication Interface" tab of the "Project
Settings" dialog box are invalid.

BACnet/IP settings, EtherNet/IP settings, and MQTT settings can be printed for FT23/1]
and HG21/1] models.

Bugs Fixed

The following problems have been fixed:

»

v

When setting Text of Drawings or Switch and Lamp parts (excluding Multi-state Lamps),

if the part size becomes larger than the screen, the screen may freeze or the text may

not be displayed when switching screens.

After creating a project file (HG5G/4G/3G/2G-V, HG4G/3G/2G-5F, HG2G-5T, HG1G/1P)

and selecting 'Modified Data Only' in the download dialog to perform the download, if

WindO/I-NV4 is not closed and a project file (FT21/1], HG2]/1]) is subsequently opened

for another download, the following issues occur:

- The "Download System Software and OS forcibly" checkbox in the download dialog
becomes disabled and remains unchecked.

- Attempting to download the project file in this state leads to an error and the
download fails.

When converting a project file to a newer version with the message switching display set

to "Specify by Text ID" the conversion fails. Depending on other parts besides the

message switching display, there may be cases where parts or screens disappear after

the conversion.

"Custom Monitor" will not be able to start in the following cases:

- When the device address of the communication driver is registered in "Custom
Monitor" and the communication driver setting is deleted from the "Project Settings".

- When control devices is set in "Custom Monitor" in an FT2J/1] project and the model
is changed to HG model.

In "Recipe Settings", if "Access to" is set to External Memory Device and the total amount

of stored data is large, the simulator will not start.

When a warning message is displayed while editing a FT2]/1] project file, it may appear

in the upper left corner of the computer screen and may not be visible.

When upgrading WindO/I-NV4 on a PC with any version of WindO/I-NV4 Ver.2.0.0 to

Ver.3.2.0 installed, the text may not be displayed in the parts.



WindO/I-NV4 Ver.3.2.0

<Runtime System Software>

The following functions have been introduced.

4

4

The following Communication Driver is supported.

- Allen-Bradley Micro800 Controller Tags(Ethernet)

The following improvements have been made to downloading a project file saved in an

external memory.

- ZNX project file or ZNV project file can be downloaded without clearing log data.

- If the OS version included in the ZNX project file matches the OS version of FT21/1]
or HG2J/1], the OS software download is skipped.

In Global Script and Script Command, you can select "Write control devices and external

device addresses only when value changes".

Changes have been made to improve security when working with project data.
(HG5G/4G/3G/2G-V models, HG4G/3G/2G-5F models, HG2G-5T models, HG1G/1P
models)

Shorten the time to display parts that use the external devices or the control devices.

Bugs Fixed

The following problems have been fixed:

4

In the Email function, when the "IP Address" of the "Outgoing mail server (SMTP)"
contains "221", the Email will not be sent but the sending result becomes "Successfully
Completed". (Only for FT2]/1] models and HG2]/1] models)

When clearing the Data Log data in the data storage area using any of the following
methods, the files (.BIN) saved in the external memory are not deleted.

- Clear the Data Log data by the Online function of WindO/I-NV4.
- Clear the Data Log data when the project data is downloaded.

- Download project data with changed settings of the data storage area or history
settings, the system software, or the OS.

<Application Software>

The following functions have been introduced.

»
4

The settings for new features of the System Software are added.

When opening the project created with a version older than Ver.3.2.0, the state of "Write
control devices and external device address only when value changes" in Global Script
and Script Command depends on the selected condition type as follows:

The selected condition type in the project | The state of "Write control devices and
created with Ver.3.0.1 or earlier external device address only when value
changes" in Ver.3.2.0

Global Script Rising-edge OFF




Falling-edge OFF

Always ON ON

Fixed Period OFF
Script Command Rising-edge OFF

Falling-edge OFF

Satisfy the OFF

condition

While satisfying the ON

condition

Period OFF

created with Ver.3.1.0

The selected condition type in the project

The state of "Write control devices and
external device address only when value
changes" in Ver.3.2.0

Global Script Rising-edge OFF
Falling-edge OFF
Period ON
(Oms)
Period OFF
(Other than Oms)
Script Command Rising-edge OFF
Falling-edge OFF
Satisfy the OFF
condition
While satisfying the ON
condition
Period OFF

» The following improvements have been made to the "Project Settings" dialog box for

FT23/1] models.

- "Storage Method of 32-bit Numerical Data for Control Devices" is added to the
"Compatible" tab. When a WindO/I-NV3 project in which "Storage Method of 32-bit
Numerical Data" is set to "from the Lower word " is opened in WindO/I-NV4, the
same setting value can be used in the Control function.

- In the "Storage Method of 32-bit Numerical Data for Control Devices" of the "System
tab, the default value was changed to "from Upper word".

» In the "Web Server" tab of the "Project Settings" dialog box, the default values for "Use
System Web Page" and "Use Custom Web Page" were changed to disabled.
(HG5G/4G/3G/2G-V models, HG4G/3G/2G-5F models, HG2G-5T models, HG1G/1P

models)

» EDS file for SX8R-ECBx can be deleted in the EtherNet/IP Setting dialog.




Bugs Fixed
The following problems have been fixed:

» If you set external device addresses to any of "Start Date and Time", "End Date and
Time", or "Date and Time at the center" in "Display of the saved data" on Line Chart X-
Axis tab and download, display do not change to the specified date and time even if you
change the device address on the external device.

» If you convert a project that contains a Line Chart from WindO/I-NV4 Ver.2.3.0 or later to
WindO/I-NV4 Ver.3.1.0, the following situation occurs.

- When Line Chart and Script Command "Period" are placed on the same screen, the
minimum time setting of "Period" does not update correctly.

- 0On FT2J/1] or HG21/1] models, when Line Chart and Alarm Log Display or Data Log
Display are placed on the same screen, the dots of "Line Height" do not update
correctly.

» For FT2]/1] and HG2]/1] models, if you configure the text ID in Text Manager using
Windows font, reopen the project, change the font of the text ID to a font other than
Windows font, and then download the project, Registration Text of the parts that use the
text ID is not displayed.

» The following phenomenon occurs in relation to the simulator function

- If you start a download while starting Simulator, the download fails.

- If you start the Simulator while the Monitor is running, an error message is displayed
when the Monitor is terminated.



WindO/I-NV4 Ver.3.1.0

<Runtime System Software>

The following functions have been introduced.

4

FT1J, HG1]J model is now supported. Following is the unique feature.

- Displaying 24-bit bitmap images

FT23/1J models and HG2]/1J models now supports the following features.
- BACnet/IP communication function

- EtherNet/IP communication function

- MQTT communication function

- Expanded device address range for LSM (HMI Special Internal Relay) and LSD (HMI
Special Data Register)

- Communication driver for Emerson ROC Protocol

- Fixed TCP port numbers 2539 and 2541 for maintenance communication (data
transfer)

Following improvements were made to the script functions.
- The trigger condition "Always ON" for global scripts has been integrated into "Period."

- The trigger condition "Fixed Period" for script commands has been integrated into
"Period."

- For the trigger condition "Period", the minimum time can now be set in the unit of
millisecond.

We have smoothed the display of line graphs, ensuring that graphs with slopes now

appear more fluid and continuous.

Changes have been made to improve security for communication. (HG5G/4G/3G/2G-V

models, HG4G/3G/2G-5F models, HG2G-5T models, HG1G/1P models)

Bugs Fixed

The following problems have been fixed:

»

For HG2J and FT2J models with OS version 1.1.1, maintenance communication using
WindO/I-NV4 cannot be performed in external network environments such as via the
Internet.

When setting Windows font on a Numerical Display or Numerical Input, numbers may not
be displayed if the font size is 150 or larger.

In the FTP client function, even if file transfer is successful, the number of successful file
transfers (LSD231) may not increase, and the number of failed file transfers (LSD232)
may increase. (Only for HG2J and FT2J models)

Depending on the USB barcode reader used, uppercase letters in the scanned barcode
may not be received. (Only for HG5G/4G/3G/2G-V models and HG4G/3G/2G-5F models)

<Application Software>



The following functions have been introduced.

4
4

The settings for new features of the System Software are added.

WindO/I-NV3 project file can now be opened with WindO/I-NV4 and change product
series to FT1] model.

Simulator function now supports "WindLDR simulation".
Changes have been made to improve security for project files.

The checkbox on the "System" tab of the "Project Settings" dialog box was renamed to
"Display the screen after reading the values of the external device addresses" from "Use
Device Cache" to make it clearer.

Bugs Fixed

The following problems have been fixed:

»

When using removable network adapter with a PC, there are instances where it may not
connect to the main unit.

When WindO/I-NV2 project file is converted to WindO/I-NV4 project file, the settings for
"SERIAL2" under the "Communication Interface" tab in the "Project Settings" (models:
HG2G-S/-5S, HG2G-S/-5S (Ethernet)) should be removed due to changes in the serial
interface. However, these settings are copied to "SERIAL1 (RS422/485)" instead.

When changing only the font in the property dialog box of the Alarm Log Display or Data
Log Display on FT2] or HG2] models, the dots of "Line Height" do not update.

When opening a WAV sound file (.wav) in the "Sound Settings" dialog box, it cannot be
opened due to an error if the beginning data of the WAV sound file does not contain fmt
information.

Sometimes, when registering parts from the editing screen to the "Part Library," Picture
may fail to be registered.

In WindO/I-NV4, there are instances where the application may freeze after repeatedly
opening and closing the "Project Settings" dialog box dozens of times.

<Web Page Editor>

The following functions have been introduced.

4

WindO/I-NV4 now supports Web Page Editor Ver.3.7.3. Please check the revision history
of Web Page Editor help for the detail.



WindO/I-NV4 Ver.3.0.1

<Runtime System Software>

Bugs Fixed

The following problems have been fixed:

4

In the Email Function, when setting two or more addresses in "To" or "Cc", sending an
email to Gmail address(es) fails while others succeed.

In the Email Function, when attaching a log data file by setting "Specify a period of
time", the log data for the specified period may not be attached.

In the Email function, if special characters are included in "Sender Name", "To", "Cc", or
"Bcc", sending an e-mail may result in a timeout error or authentication error instead of a
parameter error.

When 32,767 characters or more are set on the "Message" tab of the Message Switching

Display without using the Text Manager, messages after the 32,768th character are not
displayed correctly.

<Application Software>

The following functions have been introduced.

»

Improved the representation of a broader set of Viethamese characters by adopting UTF-
8 encoding when the Windows font is set to "Vietnamese".

Improved the visibility of the WindLDR window when downloading project data to the
FT2J model, ensuring it remains visible while accessing the control function.

Bugs Fixed

The following problems have been fixed:

4

»

When downloading project data using an expansion module with the HG5G model, the
warning message "When HG5G-V is used, make sure that the output current amount
does not exceed 50 mA." is not displayed.

When configuring 61,000 or more half-width characters without using the text manager
on the "Message" tab of the message switching display, the error message "The total
number of registered messages can be up to 61,000 characters." is not displayed.



WindO/I-NV4 Ver.3.0.0

<Runtime System Software>

The following functions have been introduced.

4

FT23-7U model is now supported. Following is the unique feature of FT2J-7U.
- Control function

The HG2J-7U model now supports the following features.

- Display the message for initializing clock data

- Download for ZNX project file saved in an external memory device

The Social Media function API has been updated for the HG2J-7U model.

When ending the monitor on WindO/I-NV4, the screen and the values of device
addresses are now kept from initializing. (This applies only to HG5G/4G/3G/2G-V models
and HG4G/3G/2G-5F models)

Bugs Fixed

The following problems have been fixed:

4

Emails containing a single quote in the body or subject cannot be sent. (This applies only
to the HG2J-7U model)

For HMI Temporary Registers (LBR) from 130 to 255, the value 0 will not be written in
the following scenarios: (This applies only to the HG2J-7U model)

When switching screens

- When changing text groups
When changing user accounts

- When resetting the display screen

When multiple data are received simultaneously via BACnet communication, the BACnet
communication response may become unstable and not recover until the power is turned
on again.

When reading and writing strings from the Custom Web Page, the target string is not
converted using the encoding method specified by LSD229. (This applies only to the
HG2J-7U model)

Images registered in Picture Manager may not be displayed if "Vertical (Counter

Clockwise)" or "Vertical (Clockwise)" selected as "Installation". (This applies only to the
HG2J-7U model)

<Application Software>

The following functions have been introduced.

4
4

The settings for new features of the System Software are added.
The following improvements have been made to enhance usability.

- When communicating with HG2J-7U model, the "Download" dialog box now shows
the type number and MAC address.



- ZNX project file option has been added for uploading project data when the external

memory device is set as the communication target.

- In the "Project Settings" dialog box, under the "Communication Driver" tab and

"Communication Driver Network" tab, the following names displayed as external
devices have been changed to "Operator Interface".

™ IIHGII

= "MICRO/I"

™ IIHMIII
Bugs Fixed

The following problems have been fixed:

4

Download fails if the user selects "Modified Data Only" in the "Download" dialog box and

proceeds to download.

Clicking the "Log in to the Account" button in the "Social Media Account Manager" dialog

box of the Social Media function does not display the login screen.

Right after saving the project from the "Change Product Series" dialog box and going

through the "Save Converted Project" dialog box, unnecessary data gets included,

causing a temporary increase in the file size of the project data.

When entering device addresses for external devices with IDs 1 to 31, it's not possible to

configure by omitting External Device Name.

When creating an HG23-7U model external memory project (ZNX project file or ZNV

project file), there might be instances where the project data is smaller than the

maximum size of 24 megabytes, yet the message "The download data size of the project

is over the limit" is displayed.

When setting the device address without specifying the External Device Name, the

following issues occur:

- When selecting the Allen-Bradley Logix Controllers (Ethernet) driver and setting it on
the Y-axis of a line chart, saving the project file results in the deletion of the screen.

- When setting the "Notify when Message Send Complete" option in the Email function
and saving the project file, the device address can not be saved correctly.

After placing a selector switch or a potentiometer on the screen, following these steps

will result in the screen being deleted.

1. Place parts such as Alarm log Display, Data log Display, or Alarm List Display on a
screen and then ungroup them.

2. Group the ungrouped components along with the selector switch or the
potentiometer.

3. Save the project file and reopen it.

When opening a WindO/I-NV2 project file or a read-only WindO/I-NV4 project file

warning message is displayed. Clicking "Cancel" on the warning message does not close

the project window.

The error message that appears when entering non-existent or unavailable device

addresses in the "Individual Settings" dialog box of the File Transfer function is not

accurate.



WindO/I-NV4 Ver.2.3.0

<Runtime System Software>

The following functions have been introduced.

4

The following functions for Line Chart have been introduced.

- The date and time can be shown on the X-axis.

- The key buttons are added to the Line Chart for the scroll.

- The cursor can be moved to the position where the screen is touched.

- The position of scale and data for both the X-axis and Y-axis can be displayed inward
or outward.

The following functions for the Web Server Function have been introduced.

- The screen of MICRO/I can be switched on the remote monitoring page and remote
control page

- The Custom Web Page can now be viewed from the System Web Page

LSM (HMI Special Internal Relay) and LSD (HMI Special Data Register) support the
functions below.

- Status monitoring of maintenance communication (LSD 227)
- Forced disconnection of maintenance communication (LSM 81)

Bugs Fixed

The following problems have been fixed:

4

In the Message Display and Message Switching Display, some of the parts are displayed
when the following conditions are satisfied.

- The part's "Trigger Condition" is not satisfied.
"Scroll" is enabled.

For the parts that can set Text ID using Text Manager, if both of the following conditions
are satisfied, the overlapped text is displayed.

- The "Use Text Manager" checkbox is ON and Windows font is set on the Text ID.
- Multiple lines of text are set and the first line is line feed only.

In the following functions, when a file is repeatedly outputted in a short period, they may
output a log with a setting that is different from the setting of "Add Time Stamp".

- Alarm Log Function
- Data Log Function
- Operation Log Function

The Modbus RTU Slave communication driver does not retry upon encountering a
communication error if "Slave Number" is set to 128 or more.

In the Web Server Function, downloading a project in which "Remote Control and
Monitoring" is disabled while the remote monitoring page is open, the screen can be



seen from the remote monitoring page unless the page is reloaded in the browser.
In the Web Server Function, Japanese strings on the remote control page may be
displayed as English strings.

In user communication, the data may not be transmitted if the following conditions are
satisfied.

- Multiple commands with the same Trigger Condition and "TXD" Type are set.

- The Trigger Conditions of those commands are satisfied.

In the E-mail Function, when sending E-mails to an "E-mail Group" that meets the
following conditions, the E-mails may not be sent to the E-mail Addresses that are
included in the group.

- 5 or more E-mail Addresses are included.

- The included E-mail Addresses use "Reference Device Address"

When the Message Switching Display satisfies the following conditions, MICRO/I may
restart.

"Scroll" is enabled.
- Windows font is used in the message.
- Switch the message to the number that text is not registered.
BACnet communication may fail to find MICRO/I from other IP subnets.
In BACnet communication, when LSM70 is turned on I-Am and COV notification sent by
COVU function are sent to the wrong destination port.
In BACnet communications, if the COV and COVU functions are used to continue sending
COV notifications at a high frequency, BACnhet communications may stop and not recover
until the power cycling.
Undefined error 5 may occur in BACnet communication when "Send Unsubscribed COV"
is enabled.
MICRO/I may restart when the subnet mask of the Ethernet port is from
255.255.255.128 to 255.255.255.254 and "Send Unsubscribed COV" of BACnet object is
enabled.

<Application Software>

The following functions have been introduced.

»
4

The settings for new features of the System Software are added.

Added Text ID search function. You can search for settings where the ID of "Text
Manager" is used in the project and move to the corresponding location.

Added "Text Manager" as a target of the font replacement function.

License authentication of "Kanji Dictionary Data" is now available for HG5G/4G/3G/2G-V
models in a project.

Added group parts similar to "Selector Switch" and "Potentiometer" to the "Sample
Library" of the "Parts Library".

Improved a phenomenon where, when Shibaura-Machine is selected for the
"Communication Driver," an invalid device address could be set.

The shapes in the "View" tab of a part are no longer hidden when the created project file
is opened with an older version.



Bugs Fixed
The following problems have been fixed:

» If the name of the project file is changed on Windows and is used for the "Reuse
screens”, the list of screens is not displayed and cannot be reused.

» If the project contains a script, which has "NG" as its "Error" status in "Script Manager",
and is used in the "Reuse Screen", WindO/I-NV4 can no longer accept control.

» When the script, added by "Import" in "Script Manager", is used in the project and
"Simulator" is executed, the script does not appear in the "Script Debugger".

» When a Character Input and a Message Display are placed on the screen and "Standard
F0008" is set on the "View" tab for each, the drawing on WindO/I-NV4 does not match
the drawing on the operator interface.

» In the "Properties" dialog box of the Numerical Display, pressing the up arrow for "Digits"
allows the user to set a value that exceeds the upper limit for the "Data type". When a
project file using this numerical display is downloaded to the operator interface, the
operator interface resets continuously.

» If the "Data Type" of the bar chart is changed to "Float32" while the "Origin", "Minimum",
and "Maximum" in the "General" tab are set in device addresses, they change to the
value.

» When a part with the device address of an external device is copied and pasted to the
project file that does not use that external device, the device address of the external
device does not get deleted.

» When copying and pasting a part with a script from another project, the script is
recognized as an OK script even if it is an NG script. As a result, invalid script downloads
can be made to the operator interface.

<Web Page Editor>
The following functions have been introduced.

» WindO/I-NV4 now supports Web Page Editor Ver.3.6.0. Please check the revision history
of Web Page Editor help for detail.



WindO/I-NV4 Ver.2.2.1

<Application Software>

Bugs Fixed
The following problems have been fixed:

» The "Download" dialog box cannot be opened when the PC does not have a valid
network adapter and one of the following conditions is satisfied.
- Select "External Memory Device" in the "Communication Settings" dialog box
Select "USB" in the "Communication Settings" dialog box



WindO/I-NV4 Ver.2.2.0

<Runtime System Software>

The following functions have been introduced.

»

Message to display on Message Switching Display can be specified by text ID on Text
Manager.

HG23-7U model supports the following functions.

- The Data Copy function

- Switch to System Mode by using RESET switch on the back of the operator interface
- Line Spacing of the installed fonts

- The Pass-Through function

- Default Gateway of Wireless LAN function

- 0O/I Link Communication with HG4F/3F/2F/2S/1F

- The communication drivers of Fuji Electric MICREX-SX, Fuji Electric MICREX-
SX(Ethernet)

Bugs Fixed

The following problems have been fixed:

4

If you repeatedly open and close the Popup Screens with and without the Data Log
Display, the value of the Data Log Display may not display.

When a Picture Display with the rotation function enabled is placed on the Popup Screen
and rotated it out of the display area, the touchscreen may restart.

In the Line Charts, if the Y-axis label uses Windows fonts and is placed so as to protrude
from the component, the touchscreen may restart.

In the Data Log Display, a long string displayed in labels may not wrap.

If you place an NMF (NV Metafile) picture on the Top layer and change to that screen,
the touchscreen may restart.

If you set "Change Display Colors" in the Message Switching Display and turn on "Flush",
the text’s color becomes light red.

When the Data log data is output to a CSV file while operating the Data Log Display,
blank spaces may be included between values.

File system time information is not updated when the system’s clock is changed using the
internal device or system area. This is applicable to HG5G/4G/3G/2G-V.

In Keyence KV (Ethernet) communication driver, when you put the parts using multiple
link relays (B), work relays (VB), and link registers (W) on the same screen, a value may
different from the device address specified in.

SNS Messages may not be sent if the external device address is included in the SNS
content.

If there are items set to "Do not use" in the e-mail function or SNS function, the device
address of the connected device to be used may be incorrectly referenced.



»

In DM Link 1:1 Communication driver, when the Event Transmission is occurred, the
event transmission data may be included in the response data to requests from the host
device. This is applicable to HG2]-7U.

If the inching function is set in User Communication and the trigger condition is set to
"While satisfying the condition", MICRO/I may reset when you try to execute it. This is
applicable to HG1P.

MICRO/I may not be able to communicate with USB barcode reader even if it is
connected with the MICRO/I.

This is applicable to HG5G/4G/3G/2G-V.

<Application Software>

The following functions have been introduced.

4
4
4

The settings for new features of the System Software are added.

Function replacing a font to the Windows font is added.

When a network adapter set in the "Network Adapter" combo box on the
"Communication Settings" dialog box cannot be detected, it is now not automatically
changed and a notification that it cannot be detected is displayed.

The percentages in the progress bar of the "Change Product Series" dialog box are
improved to understand the progress easily.

When the "Horizontal (Rotate 180°)" radio button is selected on the "Change Product
Series" dialog box and the simulator is launched, the image of the screen is displayed
with 0°.

": (colon)", an invalid character for the Tag Name, can no longer be inputted on the "Tag
Editor" window.

The performance for opening and saving a project file that uses the Trigger Condition
function or the Script function has been improved.

Bugs Fixed

The following problems have been fixed:

4
4

A script that uses "for" in the "Script Editor" dialog box is not detected as an error.
When "LogixControllers(Ethernet)" of "Allen-Bradley" is set for the communication driver
and "Expression of Device Address Format" is "Allen Bradley format", the "BCD (BCD)"
device cannot be set.

Assume "Alarm Log Settings", "Data Log Settings", "Operation Log Settings", or "Data
Storage Area Management" is changed in the project file of models other than HG2J-7U.
If the project file with the "Modified Data Only" option is downloaded, the log data does
not get reflected correctly to the operator interface.

If there is a font that is not supported by the language of the Windows OS, and the file
(*.txt or *.csv) is imported to the "Text Manager" dialog box, then the import may result
in the error even if the imported file consists of fonts that are installed in the Windows
system.

In the Trigger Condition function and Script function, when device addresses and
numerical values are mixed in a conditional expression, error message may be displayed
even though the conditional expression of "&", " | ", "A", "<<", ">>", "==" or "I="is
correct.



If the project file in which the following conditions are satisfied is downloaded to an
operator interface, the operator interface may restart repeatedly.

"Handle Logical operations as Bit operations" check box on the "Compatibility" tab of
the "Project Settings" dialog box is ON.

- Trigger Conditions of objects contain the logical operators "||" or "&&", and bit
devices and numeric values are mixed.

If the "Reuse Screens", "Copy and paste between 2 different WindO/I-NV4", or "Change
Product Series" operation is conducted and the size (width x height) of the image
registered in the "Picture Manager" dialog box of the source project exceeds the screen
size of the destination project, then the display of the operator interface may become
invalid, or the operator interface may restart repeatedly.

If you regroup the grouped parts with another part and copy and paste the regrouped
parts to another WindO/I-NV4, the trigger conditions of the child group parts may be
deleted or changed to a different trigger condition from the copy source.

If the following conditions are satisfied, after changing the product series between HG2J-
7U and other models, the drawing on WindO/I-NV4 does not match the drawing on the
operator interface.

"Use Text Area" check box is OFF and "Center-Left" is selected in the "Align Text
Horizontal" combo box.

"Zooming Conversion" radio button is ON when changing the product series.
If the following conditions are satisfied, the project file may not be saved.

- Trigger Conditions are set for objects on multiple screens and the Trigger Type is
"Satisfy the condition", or "While satisfying the condition".

- Device address of "Logix Native Tag (Ethernet)" of "Allen-Bradley" including "[]" is
set in the above Trigger Conditions.

Assume a message switching display with the blank text ID of the text manager tied to a

message. If the project file is saved and reopened, then the project file does not get

restored properly and the following problems occur.

- The screen, where the message switching display is placed, may be deleted.

- Some of the settings on the "Format" tab of the message switching display may be
deleted.

- Saving the project with a different name using "Save as" and "Compare Projects" with
the original project results in a discrepancy. The contents of the screen, where the
message switching display is placed, do not match the original.



WindO/I-NV4 Ver.2.1.1

<Runtime System Software>
The following functions have been introduced.

» The following communication drivers are now supported. This is applicable to HG2J-7U.
- YASKAWA MP920-RTU
- YASKAWA MP2000(Ethernet)

Bugs Fixed
The following problems have been fixed:

» In the Data Transfer Function using an external memory device, when downloading a
project file using USB1, the waiting time until transfer starts is longer than when using
USB2. This is applicable to HG2]-7U.

» When a project file is downloaded by the following method, the keep data will not be
cleared even if the system software version is different.  This is applicable to HG2]-7U.

- Download project file by USB Autorun Function
- Downloading the project file using Key Button

» In the communication driver of Yaskawa MP2000 (Ethernet), when writing to a plurality
of consecutive coils (MB), writing may be performed to a different coil from the specified
address.

<Application Software>
The following functions have been introduced.
» The settings for new features of the System Software are added.

Bugs Fixed
The following problems have been fixed:

» If a project file that satisfies the following conditions is opened with a WindO/I-NV4
newer than the version in which the project file was created, the project file cannot be
opened.

"Use Windows-1252 as encoding when Character Set of Windows font is "European
check box on the "Compatible" tab in the "Project Settings" dialog box is ON.

- Text in the "Text Manager" dialog box is "Windows" with the character set "Western".

» When a project file is opened in the following way, the value of the "X" and "Y" spin
boxes on the "Format" tab of the Ribbon menu cannot be changed to values greater than
100.

- Double click on the project file

- Drag and drop the project file to WINDOI-NV4.exe



WindO/I-NV4 Ver.2.1.0

<Runtime System Software>
The following functions have been introduced.

» The usable Device Address ranges of the following communication drivers are extended.
- MELSEC-Q/QnA(LINK)
- MELSEC-Q/QnA(Ethernet)

» The following communication drivers are now supported. This is applicable to HG2J-7U.
- ABB Totalflow G4/G5(RS232C/485)
- ABB Totalflow G4/G5(Ethernet)
- Panasonic MEWNET

Bugs Fixed
The following problems have been fixed:

» User communication fails if the communication data contains "0x00". This is applicable
to HG2J-7U.

» An error message may be displayed on the WindO/I-NV4's download screen after the
downloading system software is complete. This is applicable to HG2G-5T, HG1G and
HG1P.

<Application Software>
The following functions have been introduced.

» The settings for new features of the System Software are added.
» Following Product Series change is now supported.
- Changing from HG5G/4G/3G-V, HG2G-V, HG2G-5T, HG1G, or HG1P to HG2J-7U.
- Changing From HG2J-7U to HG5G/4G/3G-V, HG2G-V, HG2G-5T, HG1G, or HG1P.
» NV Metafile can be used with HG2J-7U.
» The following improvements have been made to Parts Library.
- Parts with NV metafile can be placed in the HG2J-7U project.

- When placing parts registered for HG5G/4G/3G-V, HG2G-V, HG2G-5T, HG1G, HG1P,
HG4G/3G(Multimedia), HG4G/3G, and HG2G-5F in HG2]-7U, the font size is adjusted.

Bugs Fixed
The following problems have been fixed:

» The Cross Reference information (The number of the used device addresses) for the
device address of the Trigger Condition set in the Multi-Command is doubled.

» In Simulator function, if you specify a font other than Windows font for the Y-axis label of
the Bar Chart or the Line Chart, it will not be displayed correctly. This is applicable to
HG2J-7U.



Assume one of the following communication drivers is used to create a project. If the
"Expansion Settings" in the "Communication Driver Network" tab of the "Project Settings"
dialog box are saved and the project is reopened, then the project may not be able to
restore the “Expansion Settings".

- OMRON SYSMAC CS1/CJ series(Ethernet)

- Allen-Bradley Logix Controller(Ethernet)

- Allen-Bradley Logix Native Tag(Ethernet)

- YASKAWA Electric MP2000(Ethernet)

- Yokogawa Electric FACTORY ACE FA-M3(Ethernet)



WindO/I-NV4 Ver.2.0.1

<Runtime System Software>
The following functions have been introduced.
» Improved the restriction of an object placed on the Top Layer displaying text color mixed
with magenta. (This only applies to HG2]-7U)
Bugs Fixed
The following problems have been fixed:

» The error dialog does not disappear when a TCP port number that cannot be used for
LSD213 (The preset value for port number for maintenance communication of the
MICRO/I) is specified and LSM53 is kept turned on.

» In the PLC Program Transfer Function, the downloading may fail when downloading a
ZLD Project File with a large program size to FC5A/4A.

<Application Software>
The following functions have been introduced.

» The properties for new features of the System Software are added.
» To improve usability, the following changes are made.

- The scroll bar stays in the same position when dragging objects from the "Part
Library" window.

- The focus of the objects in the "Part Library" window is released when objects are
dragged and dropped from the "Part Library" window to the editing screen.

<About WindO/I-NV4 version of HG3G-V8>
Please use WindO/I-NV4 V2.0.1 or later version for HG3G-V8 shipped after May 2022.

When downloading a project using WindO/I-NV4 V2.0.0 or earlier, the following screen may
appear during download.






WindO/I-NV4 Ver.2.0.0

<Runtime System Software>

The following functions have been introduced.

» WindO/I-NV4 now supports the HG2]-7U model. HG2]-7U has the following unique
features.
- Social Media function
- Displaying a picture at the startup
- Clock synchronization using SNTP function
- Wired USB speaker
- Wi-Fi communication using the USB dongle

Bugs Fixed
The following problems have been fixed:

» When three Goto Screen Buttons are stacked on top of each other, the top switch does
not operate.

» MICRO/I may output a CSV file with the wrong day and time to the external memory
device when function such as Alarm Log and Data Log is used.

» Assume the Recipe function is configured in the following way and is executed. While the
read scan is not complete, MICRO/I may process graphic operation with a device address
value that is different from one that has been read from the external device.

- Recipe file name is set to 9 or more characters.
- Set the corresponding Recipe to "Read-only".

<Application Software>
The following functions have been introduced.

» The properties for new features of the System Software are added.

» The “Part Library” function has been added to save the configuration of the parts so that
users can conveniently reuse the frequently used parts.

» To improve usability, the following changes are made.
- Parts' view and font settings are changed to look better when placed on the screen.
- Device addresses and trigger conditions for the parts are automatically set.

- "Default Preference" has been added to the "WindO/I-NV4 Options" dialog box for
configuring the default values of the parts and screen properties.

» Newer Microsoft Word versions can now be printed with Word document of Print
function. Please refer to Readme for details.

» The performance for opening and saving a project file has been improved.

Bugs Fixed



The following problems have been fixed:

» Even though the function for the "Use Large Password screen" check box does not exist,
the setting still exists on the "Project Setting" dialog box.

» The setting dialog box for the corresponding module may not open when double-clicking
the module on the "Module Configuration" dialog box.

<Web Page Editor>
The following functions have been introduced.

» WindO/I-NV4 now supports Web Page Editor Ver.2.18.0. Please check the revision history
of Web Page Editor help for detail.



WindO/I-NV4 Ver.1.16.1

<Runtime System Software>

Bugs Fixed
The following problems have been fixed:

» While the Event Recording function is set, or while data is being recorded with a Key
Button, Multi-Button, or Multi-Command configured with the recording function, MICRO/I
may restart when the display of picture and parts with JPEG format images is repeated.

» While the screenshot or files such as history function are being output to the

external memory device frequently, if File Screen for movie files is opened,
then MICRO/I may restart.

<Application Software>

Bugs Fixed
The following problems have been fixed:

» If two or more parts that have two or more different device addresses of ABB Totalflow
G4/G5 (RS232C/485) or Totalflow G4/G5 (Ethernet) are placed on one screen, the project
file is saved, the parts are deleted, and the project is saved again, the device address
may either disappear from the part or change to a different device address.



WindO/I-NV4 Ver.1.16.0

<Runtime System Software>

Bugs Fixed
The following problems have been fixed:
» When the "Image Type" of Meter is "None", the needle drew before is remains if the
value of Reference Device Address is changed as following.
- changed from minimum value to other value
- changed from max value to other value

» Inthe DM LINK (1:1) communication driver, the Device Address sent by the Event
Transmission is different if the Device Address is 5 digits.

This applies to HG5G/4G/3G/2G-V.

» In the Data Log function, the operator interface restarts if log data is cleared while
outputting the CSV file to the external memory.

<Application Software>
The following functions have been introduced.

» The problem, which WindO/I-NV4 does not run properly by the language setting of
Windows QS, is improved.

Bugs Fixed
The following problems have been fixed:

» In "Module Configuration" dialog box, when Analog I/O Module FC6A-J8CU1/FC6A-J8CU4
is dragged from the expansion module/cartridge list and placed, and the analog module
setting is opened, the following problems occur.

- RO, TO and B cannot be edited even if NTC Thermistor is selected in Signal Type.
- When you select Signal Type other than NTC Thermistor, RO, TO and B can be edited.

» When opening a project file that uses the "Symbol" character set in the Windows font
setting of a registration text, the edit screen shows invalid text. Saving and downloading
the project file causes the operator interface to display invalid text.

» Following problems occur when the Drawing of a horizontal line or a vertical line is placed

on the edit screen.

- If the line gets imported to Picture Manager and used as a picture for a part, then the

line does not get displayed on the edit screen.

- If the line has the size 200 or more and gets imported to Picture Manager, then the
line does not get displayed on the Picture Manager.

» When multiple drawings are selected on the edit screen, the context menu behaves in
the following manner.

- Executing "Make Same Width" in "Size" executes "Make Same Height" instead.



- Executing "Make Same Height" in "Size" executes "Make Same Width" instead.

<Web Page Editor>
The following functions have been introduced.

» WindO/I-NV4 now supports Web Page Editor Ver.2.17.2. Please check the revision history
of Web Page Editor help for the detail.



WindO/I-NV4 Ver.1.15.0

<Runtime System Software>
The following functions have been introduced.

» In the Interface Settings, the Connect Speed can be selected from "10Mbps" and
"10/100Mbps". This is only applicable to HG1P.

(When "10/100Mbps" is selected, attach a ferrite core to the communication cable. For

details, refer to Instruction Sheet or WindO/I-NV4 User' s Manual.)

» In the following Communication Drivers, the device types "X (Input Relay(Bit))" and "WX

(Input Relay(Word))" can be used as write device addresses.
- MELSEC-AnA(LINK)

- MELSEC-AnN(LINK)

- MELSEC-Q(CPU)

- MELSEC-Q/QnA(LINK)

- MELSEC-Q/QnA(Ethernet)
- MELSEC-FX(CPU)

- MELSEC-FX2N(CPU)

- MELSEC-FX3UC(CPU)

- MELSEC-FX3U(Ethernet)
- MELSEC-FX5U(LINK)

- MELSEC-FX5U(Ethernet)

» In the project transfer function of Key Button, Multi-Button, and Multi-Command, you can

select whether to display the Result window after downloading the project.

Bugs Fixed
The following problems have been fixed:

» If the following operations are performed while using the change text Group, the screen

display may not be updated. This applies to HG5G/4G/3G/2G-V.
- Switch the Base Screen
- Open or close the Popup Screen

» When the MICRO/I communicate with the external device through multiple serial ports,
the reception of data transmitted from the external device may fail at the serial port with

a high communication speed. This applies to HG5G/4G/3G/2G-V.

<Application Software>
The following functions have been introduced.
» The properties for new features of the Runtime System Software are added.

» When "Clock" or "Elapsed Time" is selected in "Calendar Type" combo box of a Calendar,
the "Use Value of Device Address" setting can be changed on "Object List" window.



4
4

Improved the saving of Tag Names and Comments.
Added error message when the download fails.

Bugs Fixed

The following problems have been fixed:

»

If the device address of the same external device is assigned in the "Project Settings"
dialog box and the "Global Script" dialog box, and the external communication driver is
changed, the "Trigger Condition" settings of the "Global Script" dialog box are deleted.
After changing the uppercase or lowercase letters of the project file name on Windows
OS (Example: changing "abc.pn4" to "Abc.pn4"), if the project file is opened in a newer
version of WindO/I-NV4 than the one in which the project file was created, an error
message is displayed and the project cannot be opened.

If about 9600 scripts are created in the "Script Manager" dialog box and save the project
file, WindO/I-NV4 freezes when the project file is opened.

If HG2G-5T project is created by the Chinese version of WindO/I-NV4 and perform the
following operations, the display resets.

1. Place a Goto Screen Button and set "Open User Account Setting Screen" as the "Action
Mode" combo box.

2. Download the project file, and press the Goto Screen Button on the display to open the
User Account Setting Screen.

3. After pressing the "Edit" button, press the Character Input of "User" setting to open
the keypad.

4. Press the "Num&Sign" button.

After placing a Goto Screen Button on the Base Screen and setting "Open User Account
Setting Screen" in the "Operation Mode" combo box, if a Popup Screen with the same
number as the Base Screen is created, when you press the Goto Screen Button on the
display that downloaded the project file, an error message appears.

If multibyte characters are entered in "Constant(Character)" or "Registering
Constant(Character)" of the "Data Settings" dialog box of User Communication, the
display may keep resetting after downloading the project file.

When the project file created by WindO/I-NV4 Ver.1.8.0 to Ver.1.13.1 contains a Pie
Chart, the "Image Type" of the Pie Chart will be automatically changed to "Standard"
after the following operations.

1. Set "Image Type" to "None" and save the project file.

2. Open the project file in a newer version of WindO/I-NV4 than the one in which you
created the project file.

If a Message Switching Display is set as follows and the project file is downloaded, the

plate color of the Message Switching Display may not be displayed correctly.

- Set the external device address to the "Trigger Device Address" in the "General" tab.

- Set two or more messages in the "Settings" in the "Messages" tab, and set "Yes" in the
"Change" column.

- Set a different color from the "Plate Color" in the "View" tab to the "Plate Color" column
of the message which set to "Yes" above.

In the "Individual Settings" dialog box of the Data Log, after turning off the "Output
Items" check boxes in the "Data" tab, open another tab, and then click the "OK" button,
the "Output Items" check boxes saved as ON.



» If the Windows font is set as the Registration Text of a Multi-State Lamp and the
following operations are performed, the screen which the Multi-State Lamp is placed is
not displayed correctly.

1. Set a different language from the language of the Windows OS running WindO/I-NV4
in the "Character Set" combo box of the "Font" dialog box (e.g. set "Chinese" in the
"Character Set" combo box when the Windows OS is Japanese).

2. Open the project file in a newer version of WindO/I-NV4 than the one in which you
created the project file.

» After turning on the "Custom Web Page Files" check box on the "Download" dialog box
and the project file is downloaded, if "Files to External Memory Device" or "Files to
External Memory Device while running" is performed, the custom Web page files will be
downloaded.



WindO/I-NV4 Ver.1.14.0

<Runtime System Software>
The following functions have been introduced.

» Following features have been added to the calendar.
- Device address value can now be displayed as a date.
- Device address value can now be displayed as an elapsed time.
- New display format is added.
- Font items are added to the selection.

» When the signal type of FC6A-J8CU1 (Analog Input Module) is configured to PTC
thermistor (threshold), minimum and maximum values can be configured.

Bugs Fixed
The following problems have been fixed:

» When the following parts are placed on a base screen or popup screen, which has a
"Number value of 16" or above, data saved in external memory cannot be displayed on
that part.

- Line Chart
- Data Log Display

» When the FTP Server function is used to transfer a file to the folder that contains many
files, communication with PLC may fail.

» If the "Sort" setting in Data Log Display is set to "Newer to Older" and the user press the
"..." area of the display, where data does not fit within the display area, then full-screen
mode displays different data.

» If the "Sort" setting in Data Log Display is set to "Newer to Older", then the data's
default display position becomes different from that of "Older to Newer".

» If the Data Log Display’s "Label Row" is turned off, pressing the "..." area of the display,
where data with many characters is shortened, does not display the unshortened data.

<Application Software>
The following functions have been introduced.

» The properties for new features of the Runtime System Software are added.

» The HG5G/4G/3G-V project file can nhow change product series to HG2G-5T, HG1G, and
HG1P.

»  WindO/I-NV4 now supports Windows font other than TrueType.

» The following data type is now supported on Allen Bradley Logix Native Tag(Ethernet).
- Add-On-Defined
- Module-Defined

» The following usability improvements are made.



- "Sub Host Communication" tab, "O/I Link" tab, and "Printer" tab in the "Project
Settings" dialog box are now always visible.

- Performance for opening and closing the "Text Manager" dialog box has been
improved.

- WindO/I-NV4 now does not start up, if the "Beta: Use Unicode UTF-8 for worldwide
language support" checkbox is turned on in Windows 10 setting.

Bugs Fixed

The following problems have been fixed:

4

If MEMCPY function's return value is used for the value of a variable (for example, [LDR
0000] = MEMCPY(LDR 0100, LDR 0200, 10)) and the following function(s) are written
after that statement, then downloading the project and executing the script resets the
display continuously.

- STRCAT
- STRCUT
- STRLEN
- STRSTR
- ASCII2DEC
- DEC2ASCII

If an invalid device address is inputted in the "Script Editor" dialog box and the "Error
Check" button or "OK" button is clicked, then "0:" is placed on top of that device address.

WindO/I-NV4 freezes if the "OK" button is clicked in the "Script Editor" dialog box after
writing a script that fulfills the following conditions.

- The number of left square bracket and right square bracket is the same.
- Right square bracket exists on the left of the left square bracket.

After the following operation is performed and the script changes from NG to OK, saving
the project file, opening it, then downloading it to the display results in continuous
display reset.

- Communication driver is changed in the "Communication Driver" tab of the "Project
Settings" dialog box.

- Allen-Bradley Logix Native Tag(Ethernet) communication driver’s L5K file is changed in
the "Communication Driver Network" tab of the "Project Settings" dialog box.

- Allen-Bradley Logix Native Tag(Ethernet) communication driver’s setting in "Tag
Settings" dialog box is changed.

- ABB Total Flow communication driver’s Application Name is changed in the
"Communication Driver Network" tab of the "Project Settings" dialog box.

- The tag name is changed in the "Tag Editor" window.

- The number of LKR or LK is changed in the "Data Storage Area Management" dialog
box.

- The product series is changed.
- Copying and pasting a part that has a script setting in between different project files.

Script error occurs if @ word device that treats bit device as its bit number (for example,
IDEC PLC "WM 00000-00"), is used for Bit Function(s) or assignment statement(s) in the
"Script Editor" dialog box.



Assume importing a CSV file from the "Text Manager" dialog box. If the CSV file contains
a color setting column with a value of white(255), then the "Text Manager" dialog box
does not display white color properly.

On Windows OS except English, the CSV file cannot be imported properly to the "Text
Manager" dialog box if the CSV file contains a Windows font that has a different name for
the English and other languages. (for example, "MS Gothic" and "MS T v o").

The project file cannot be opened if a user attempts the following operation. Deletes
Administrator from all user’s security group, turns off "Use Security functions" check box,
sets a password, then saves the project file.

An error message is displayed when the autosave is executed while changing the product
series.



WindO/I-NV4 Ver.1.13.1

<Application Software>
The following functions have been introduced.

» Default values of "Auto OFF" and "Halve the Brightness" in "Project Settings" dialog box
are changed to Valid.



WindO/I-NV4 Ver.1.13.0

<Runtime System Software>

The following functions have been introduced.

4
4

LSD (HMI Special Data Register) now supports to display the MAC address of MICRO/I.
The following Communication Drivers are now supported.

- ABB Totalflow G4/G5(RS232C/485)

- ABB Totalflow G4/G5(Ethernet)

A string can now be changed to the language specified by LSD229 when Device
Address's string is read or written on the Custom Web Page.

The video input image is now enlarged accordingly to the size of the Video display or the
screen size if it is displayed in full-screen. This applies to HG5G/4G/3G-V

Bugs Fixed

The following problems have been fixed:

4

If "Start scrolling after displaying message" is enabled in the following parts and the size
of the entire character string to be displayed is bigger than the size of the display area by
1 or 2 dots, then the scrolled character string is not displayed correctly.

- Message Display
- Message Switching Display
- Alarm List Display

If the "Button" satisfies all of the following conditions, then the area of placed parts,
which overlaps with the "Button", is filled with the background color.

- The View Switching Method is set to "No Image"
- The Visible Condition changes from satisfied to not satisfied

If the font of the text is set to "Stroke" and the text is displayed on the Simulator, then
the text may become underlined.

If the Align Text is set to "Left" in the following parts, then the "Expand display area of
text for parts placed on the Top Layer" compatible function cannot be enabled.

- Numerical Input

- Character Input

- Message Display

- Message Switching Display
- Numerical Display

With WindO/I-NV4 Ver.1.12.0 or later, the Communication with PLCs of Fuji Electric is not
working by using Communication Driver of '"MICREX-SX". This is applicable to
HG5G/4G/3G/2G-V.

<Application Software>



The following functions have been introduced.

4
4

The properties for new features of the Runtime System Software are added.

The following new type numbers and improvements are added to the "Module
Configuration" dialog box.

- Expansion module type numbers for Removable terminal block (Push-in) are added.
- Improved operability.

Bugs Fixed

The following problems have been fixed:

»

The project file can be downloaded even if the "Dynamic Rotation" check box, which is in
the properties dialog box of Picture Display, is turned ON and the device address setting,
which is in the "Dynamic Rotation" dialog box, is set to blank.

When a device address is not set to the Lamp or Command parts, a copied part cannot
be pasted.

Assume two WindO/I-NV4s are launched. If Line Chart, whose "Label" setting has Text
ID, is copied from WindO/I-NV4 and pasted to another WindO/I-NV4, Line Chart is not
pasted and controls on the "Text Manager" dialog box are disabled.

If the "Label" setting of the X-axis for Line Chart is enabled, the Text ID and Text of label
are not displayed on the "Object List" window.

If "Zooming Conversion" is selected and product series is changed, the size of the tick of
the Y-axis for Line Chart does not adjust accordingly to the size of the screen.

Assume Screen contained Line Chart, whose "Label" setting has Text ID, is reused in
another project file. If Text IDs are duplicated and not overwritten, then a text of the
pasted Line Chart is not displayed properly.



WindO/I-NV4 Ver.1.12.3

<Runtime System Software>

The following functions have been introduced.

4

MICRO/I has been improved to communicate stably with a barcode reader.

Bugs Fixed

The following problems have been fixed:

4

MICRO/I restarts when the alarm log data is cleared by the Online function of WindO/I-
NV4. This applies to HG4G/3G/2G-5F.

The following problems occur in the Message Switching Display with scroll enabled.

- MICROV/I restarts when the "Central European” font message is displayed.

- The message does not get displayed in the display area of the Message Switching
Display if the "Expand display area of text for parts placed on the Top Layer"
compatible function is enabled and the Message Switching Display is placed on the
top layer.

The following problems occur if the LKR(HMI Keep Register) is used in the "Store current

logging-in User Name to Device Address" setting of the security function.

- The "device range error" occurs in the MICRO/I.

- The Simulator does not start.

If the "Flash" is enabled in the "When Data Over" setting of the Numerical Display and

one of the device addresses' values, which stores either of "Minimum" or "Maximum" of

the "Range", is changed, then the value may not get displayed.

The data row format of the CSV file outputted by the Data Log function is different from

that of WindO/I-NV4 Ver.1.6.0 or older.

Even if the "Sample Time" setting, which is in the Output Items of Data Log setting, is

turned OFF, "Sample time" is outputted in the CSV file.

The display of the parts, which have been operating while the backlight is turned off,

may not get reflected on the screen when the backlight is turned on.

Assume downloading a program to a password-locked PLC using the PLC program

transfer function with changed password entry screen keypad. The download does not

start even if the correct password is entered.

The confirmation dialog of copy operation in the file manager function of the System

Mode may get displayed as a confirmation dialog for another function. This applies to

HG5G/4G/3G/2G-V.

<Application Software>

Bugs Fixed

The following problems have been fixed:

»

The header of the CSV file outputted by the Data Log function is different from that of



WindO/I-NV2.
» Following is the list of problems for display frame; display frame is shown when you
select Ribbon ->"View" tab ->"Show/Hide" ->"Popup Screen".

- Cannot move with the arrow keys.
"Undo" and "Redo" do not function.
- Cannot select (if the part that is calling the Popup Screen is grouped).



WindO/I-NV4 Ver.1.12.2

<Runtime System Software>

The following functions have been introduced.

» Improved the receive processing of TCP/IP communication data. This is only applicable to

HG4G/3G/2G-5F.

Bugs Fixed

The following problems have been fixed:

4

Receiving a large number of UDP packets from devices in the same network may reset
the MICRO/I.

The "Calculate 16-bit data with 16-bit" setting in the "Compatible" tab in the "Project
Settings" dialog box can not be disabled.

If MICRO/I is configured as O/I Link Slave, the value of Device Address for the external
devices may not get reflected.

A file with name length (which includes file extension) over 101 characters cannot be
created. This is applicable to HG5G/4G/3G/2G-V.

When the width of the "Buttons", "Lamps", "Data Displays" or "Text of Drawings" is set to
800 or more, characters may not get displayed in the displayable area of 800 dots or
more from the leftmost displayable area. This is applicable to HG5G/4G/3G-V.

When "Installation" is set to "Vertical (Clockwise)" and a part that is placed on the top

layer has an X-coordinate value of 0, the MICRO/I resets. This is applicable to
HG5G/4G/3G/2G-V.

<Application Software>

Bugs Fixed

The following problems have been fixed:

»

When a project file, which uses a Windows font that does not exist on the PC, is opened,
saved, reopened, then downloaded, the display of the editing screen of WindO/I-NV4 and
the display of the MICRO/I becomes different.

If you use a script that contains "&" or "<" in the script name, you cannot run the
simulator.

Saving a project file after performing one of the following operations may create an

incorrect project file due to insufficient memory.

- Increasing the magnification of the editing screen and opening several dozen base
screens or popup screens.

- Create a large number of base screens or popup screens and move the scroll bar in
the "Screen List" window.

If all of the following are satisfied in the "Text Manager" dialog box, the text ID used in
the project may not get displayed correctly on the MICRO/I.



- 2 or more text group is used.
- Characters are only set in the leftmost text group for Text IDs in ID51 or later.

» During copying and pasting parts between two or more WindO/I-NV4, if the "Picture
Name Setting" dialog box is displayed on the paste-destination WindO/I-NV4 and the
project file of the copy source is saved, then the saved project file becomes corrupt.

» When "Font" is set to "Windows" on the "Numerical Input" or "Numeric Display", the
selected Windows font may not get displayed correctly.

» Assume "Use Compatible functions from previous version" checkbox is OFF in the
"WindO/I-NV4 Options" dialog box and project file created before Ver.1.12.0 is opened. If
the following conditions are satisfied, then the objects’ character alignment of the text
displayed on the edit screen becomes different from that of the previous version.

"Use Text manager" checkbox is ON and text ID that uses Windows font is used in
the property of the object.

"Align Text Horizontal" set to an alignment choice other than "Left".
» In the "Font" dialog box, fonts whose names begin with "@" cannot be used.

» When replacing the device address(es) set for the parts' trigger condition(s), the device
addresses set for parts' trigger conditions that are outside of the replacement search
range may get replaced.

» When opening a project file with a password set in a newer version of WindO/I-NV4,
pressing the "Cancel" button in the "Check User Name and Password" dialog box does
not close the project file.

» When a comma is set as a Decimal symbol on Windows, the project file with
Product Series set to either HG5G/4G/3G-V or HG2G-V cannot be
downloaded.

<Web Page Editor>

Bugs Fixed
The following problems have been fixed:

» WindO/I-NV4 now supports Web Page Editor Ver.2.17.1. Please check the revision history
of Web Page Editor help for the detail.



WindO/I-NV4 Ver.1.12.1

<Runtime System Software>
Bugs Fixed
The following problems have been fixed:

» The MICRO/I may not operate even if the power is turned on. This is only applicable to
HG2G-5T.



WindO/I-NV4 Ver.1.12.0

<Runtime System Software>

The following functions have been introduced.

4
4

v v Vv Vv

Data log display has been added.

The following functions have been added to the security function.
- Increased maximum user name's length to 16 words.

- Increased types of string that can be used for the password.
- User can now create a password input screen.

- The character string can now be hidden when changing the password in the user
account setting screen.

The following functions have been added to the alarm log function.
- The level can be now set for each alarm.

- When displaying an alarm on the alarm log display, the display order and display color
can now be changed according to the set level.

The following functions have been added to the data log function.

- CSV file format that can be used for functions such as trend bar in the Web Page
Editor can now be outputted.

- The output file path of the CSV file can now be outputted to the device address.

The runtime system of the expansion module can now be updated.

The device address value can now be processed with multiple data types in a script.

Enabled to send email using the UTF-8 character code.

When displaying Windows font text set in the text manager on a part, the text alignment
setting now is reflected on that part.

Bugs Fixed

The following problems have been fixed:

4

»

When the default user is selected in the security function, the following problems occur in
default screen.

The LSM1 value becomes 1 not only in the second scan but also in the fourth scan.
The LSM2 value becomes 1 not only in the first scan but also in the third scan.

- The LSM3 value becomes 0 not only in the first scan but also in the third scan.
The LSM8 value is 0 after the third scan.

While the line chart with gridlines is stopped from updating if the chart gets scrolled, the
gridlines get displayed on the top of the chart.

When the following operations are applied to the line chart, data that is not sampled get
displayed.

- Data is sampled while the line chart update is stopped.

- The cursor is moved after changing the display points.

The value set for the "Monitoring Period" in the alarm log function may not get reflected.



When backup data error occurs, MICRO/I may startup with minimum display brightness.
If MICRO/I's power supply is turned off while downloading project data, MICRO/I may
repeat restart.

If a bit value is written to a word device in the global script in the simulator, then other
untouched bits of that word device become 0.

When "Enable Touch Sound" in project settings is enabled and the function key gets
pressed, touch sound does not get played. This is only applicable to HG1P.

In communication using RS422/485, communication with an external device
and O/I link communication may fail. This is only applicable to
HG5G/4G/3G/2G-V.

<Application Software>

The following functions have been introduced.

4
4

4
»

The properties for new features of the Runtime System Software are added.

The following improvements have been made to improve usability.

"Start Monitor" and "Simulator" are now executable with the "F8" key and "F5" key.

- When the "Download" dialog box is opened, the "Values of Keep Devices", "Alarm Log
data", "Data Log data", and "Operation Log Data" checkboxes now get cleared.

- When the "BACnet/IP Setting" tab of the "Project Settings" dialog box is opened,
pressing the help button now displays the BACnet/IP function description page.

- In the "Target IP Address" dialog box and "Target IP Address Settings" dialog box, the
meaning of each setting has been clarified. Also, the initial setting now sets the IP
setting in the "Communication Interface" tab of the "Project Settings" dialog box to a
display.

- The default value is now set to "Channel Name" in the "Data Log Settings" dialog box.

- Words indicating "line width" have been unified to "Line Width" in the English version
of WindO/I-NV4.

- In the "E-mail" tab of the "Project Settings" dialog box, the name of the "Use secure
connection (SSL)" checkbox has been changed to make it easier to understand that it
also supports TLS.

- The shortcut function created in the Windows OS start menu during WindO/I-NV4
installation has been moved to the WindO/I-NV4 help menu.

The print function now supports the new functions of WindO/I-NV4 V1.12.0.

WindO/I-NV4 now supports the HG1P series with serial interface (RS232C).

Bugs Fixed

The following problems have been fixed:

4

"Text Manager" dialog box has the following problems.

- The display continuously starts restarting when a project is saved and downloaded.
The project's default group column in "Text Manager" must be dragged and dropped
and must be changed from a number other than "1" to "1" before saving the project.

- If you edit text while selecting multiple cells with different font settings, the font
settings of the edited cells become blank. If you close the "Text Manager" dialog box
with the "OK" button, you will not be able to open the "Text Manager" dialog box



anymore. Also, saving the project file will break the project.

- If you copy a cell that has a Windows font setting, paste it into another cell, and edit
the text, then the edited text does not get displayed on the display after you
download the project.

- If you change the default group after changing the order of any group, the default
group may not be saved correctly.

- Deleting the text group may not work correctly after changing the order of any group.

- If you copy any cell, paste it into any cell, and immediately change the text in the

pasted cell, the font setting of the copied cell does not get reflected in the pasted
cell.

If there exists a command that has "Device Address" as its "Type" in the "User

Communication" tab of the "Project Settings" dialog box, the following problems occur.

- Receive command's "Number of bytes" spin box can set invalid value.

- If "Type" in "Command Settings" dialog box is changed, "Conversion Type" may
bceome not set.

If the following window is moved to the secondary monitor while the secondary monitor

is connected and WindO/I-NV4 is closed, then unless the secondary monitor is connected

at the time of the next startup, the window will not be displayed.

- "Project" Window

- "Parts List" Window

- "Screen Diagram" Window

- "Screen List" Window

- "Tag Editor" Window

- "Toolbox" Window

- "Object List" Window

- "Comparison Result" Window

- "Information" Window

- "Cross Reference" Window

When "Increment Address" or "Increment Bit Number" is enabled, Numerical Display and

Bit Write Command may not be pasted.

When reusing a screen from WindO/I-NV4 Ver.1.7.1 or earlier project, no error message
gets displayed even though the screen cannot be reused.

When "External Memory Device" is selected from the "Communication with" radio
buttons, which are in the "Communication Settings" dialog box, the "Screen Monitor",
"Custom Monitor", and "Batch Monitor" dialog boxes of the simulator cannot be opened.
If a project with "Use Password to Open Project" checkbox in the "Security" dialog box
turned on gets uploaded and the "Cancel" button gets clicked in the "Confirm Password"
dialog box, then WindO/I-NV4 crushes.

When the following conditions 1 to 3 are satisfied and the project file is saved and
opened, the device address settings for Emerson ROC Protocol and Allen-Bradley Logix
Native Tag (Ethernet) are deleted. Also, when the following conditions 1 to 4 are satisfied
and the project file gets saved and opened, the project file cannot be opened, or a
specific dialog box cannot be opened.

- Condition 1: "Allen Bradley format" is selected in the "Expression of Device Address
Format" setting in the "Tag Editor" window.



- Condition 2: In the "Communication Driver" tab of "Project Settings" dialog, "Allen-
Bradley" is selected for "External Device Communication 2" and manufacturer other
than "Allen-Bradley (except for Allen-Bradley Logix Native Tag (Ethernet)) " or "Not
used" is selected for "External Device Communication 4".

- Condition 3: External device's device address with no [/] (slash) contained, which is
from "External Device Communication 4, is used in the project file.

- Condition 4: External device's device address other than Emerson ROC Protocol and
Allen-Bradley Logix Native Tag (Ethernet) from "External Device Communication 4" is
used in the project file.

» If you download a project with a duplicated screen without opening it on the edit screen,
no error will be displayed even if the part is off the screen.

» If the "Cancel" button is pressed after changing the operation authority setting in the
"Security Settings" dialog box, the changes are saved.

» If a "Fill" part exists on the back of another part in the editing screen, then clicking on
the part in front of the "Fill" part selects the "Fill" part.

» If a script is imported by using "Import" button in "Script Manager" dialog box and
project file is downloaded to the display, display may restarts repeatedly.

» If bit and word devices are mixed in the conditional expression of an if or while
statement in the script with relational operators (>, <, >=, <=) or arithmetic operators
(+, -, *, /, %), the following controls may delete bit device address(es) in the script:

- Changing the product series.

- Copying and pasting a script command, multi-button containing a script, or multi-
commands containing a script from other WindO/I-NV4.

- Changing the communication driver.

» If a script uses the bitwise logical OR (|) or the bitwise logical AND (&) in a conditional
expression and one of the following operator, that script is considered invalid and the
project file may not be downloaded.

- The logic inversion (!)
- The relational operators

» Copying and pasting a script command, multi-button containing a script, or The text may
become garbled when a WindO/I-NV2 project is opened in WindO/I-NV4; ANSI must be
set for Windows font character set and European text string must be entered in WindO/I-
NV2 before opening the project in WindO/I-NV4.

» When opening a project file that uses Windows font, a warning message warning
Windows font is not installed may get displayed even if that Windows font is installed in
the OS.

<Web Page Editor>
The following functions have been introduced.

» WindO/I-NV4 now supports Web Page Editor Ver.2.17.0. Please check the revision history
of Web Page Editor help for the detail.



WindO/I-NV4 Ver.1.11.4

<Runtime System Software>

Bugs Fixed

The following problems have been fixed:

»

PLC Program Transfer function is failure in case of the following.

- Interface of Key Button is selected "Ethernet".

- Interface of Key Button is selected "COM2(422/485)". This is applicable to
HG5G/4G/3G/2G-V.

When "Backlight" function in "Project Settings" is enabled, if turning off the power of

MICRO/I when the brightness is reduced while this function works, it starts with the

brightness reduced. This is applicable to HG5G/4G/3G/2G-V.

In Simulator function, if the following conditions are satisfied, Popup Screen may not be
closed.

- The screen with more than one Goto Screen Button or Goto Screen Command is
displayed.

- More than one Popup Screen is opened.

- Trigger conditions of more than one "Close Popup Screen" are satisfied at same time.

In Simulator function, some parts placed on the Top layer may not be displayed.

If the following conditions are satisfied, the value and unit are overlapped in Numerical
Input and Numerical Display.

- "Font" of "Format" tab is selected "Windows".
- "Align Text" of "Format" tab is selected "Left" or "Center".

- "Align the text area (Character Input/Message Display/Numerical Input/Numerical
Display)" in "Compatible" tab of "Project Settings" is enable.

<Application Software>

Bugs Fixed

The following problems have been fixed:

»

If an HG5G/4G/3G/2G-V project file gets opened with a double-click, and PC's user
name contains whitespace character, WindO/I-NV4 freezes.

When a project file that has either one of the following part objects is saved, closed,
reopened, and Product Series is changed, the process aborts.

- Multi-Button. The first item in "Function List" must be "Key" and its "Key Type" must
be one of the followings.

"Download Project"
"Download PLC Program"
"Upload Project"



"Upload PLC Program"

- Key Button. Its "Key Type" must be one of the above, and it must be grouped with
other object(s).



WindO/I-NV4 Ver.1.11.3

<Runtime System Software>

Bugs Fixed

The following problems have been fixed:

4

When the "Save the data of Data Log and display in Line Chart" check box on "External
Memory Device" tab of Data Log function is ON and the saved data is displayed on Line
Charts, changing the visible or invisible of the saved data by Trigger Conditions may reset
the MICRO/I.

If data of value for position of cursor is stored in device address with Line Chart, an
occupied device addresses will be set as "2 words" x "Number of Channels" instead of
being set as "Number of Words for Data type of Y-axis" x "Number of Channels".

The "User Communication' will not work which is set to Protocol 4 to Protocol 7 on
"Communication Interface" tab of "Project Settings" dialog box.

When using Downloader to upload data from External Memory of MICRO/I, an
unnecessary communication may be happened.

The Communication with PLCs of Fuji Electric is not working by using Communication
Driver of "MICREX-SX". This is applicable to HG5G/4G/3G/2G-V.

A first character of string on Character Inputs will not be displayed when the string is

typed as long as a length which is set to "Display Digits" on "General" tab of Character
Input.

<Application Software>

Bugs Fixed

The following problems have been fixed:

»

When Product Series of HG2G-5T, HG1G, HG1P, HG4G/3G(Multimedia), HG4G/3G or
HG2G-5F project file is changed to HG5G/4G/3G-V or HG2G-V, settings of "O/I Link Slave"
or "O/I Link Master," which are set in COM2, SERIAL1(RS422/485), or COM(RS422/485)
of "Communication Interface" tab on "Project Settings" dialog box get deleted. Also, at
the same time, Communication Driver settings, which are set in "External Device
Communication 1" of "Communication Driver" tab on "Project Settings" dialog box, get
deleted and Device Address corresponding to Communication Driver get deleted from
each setting.

In "Data Log Settings" dialog box, when Output Data contains data which "Data Type" is
"Bit", Device Address of the data is deleted after Product Series is changed.

In Properties dialog box of Line Chart, If "Device Address Display" is selected from "Chart
Type" drop-down list in "General" tab and Read-only Device Address is set in "Reference
Device Address" text box of "Y-Axis" tab, the Device Address is deleted after Product
Series is changed.

In HG4G/3G(Multimedia), HG4G/3G or HG2G-5F project file, if "LEX" or "LEY" is used in
Trigger Condition of Parts, the Trigger Condition does not function properly when the



Product Series is changed to HG5G/4G/3G-V or HG2G-V and the project file is

downloaded.

Below is a list of problems for downloading with Ethernet.

- If "Change the network settings to following after downloading the project data" is
used, an error message gets displayed at the end of the download.

- if "Obtain an IP address automatically (DHCP)" is selected in "Communication
Interface" tab on "Project Settings" dialog box, an error message may get displayed
at the end of the download.

If settings file of WindO/I-NV4 is broken, WindO/I-NV4 does not launch properly.

If 24 hours elapses with no operation after creating a project file of HG5G/4G/3G-V or

HG2G-V, WindO/I-NV4 does not work properly.

If data, which "Data Type" is "UBIN16(W)" and "Counting Method" is "Hexadecimal," is

added to Output Items in "Data" tab on "Individual Settings" dialog box of "Data Log

Settings" dialog box, Data Log function may not work when a project file is downloaded

to display.

If programs that read from and write to External Device Address are written in scripts,

Simulator may not start.



WindO/I-NV4 Ver.1.11.2

<Runtime System Software>

Bugs Fixed

The following problems have been fixed:

4

4

If the output settings for external memory device in alarm Log, Data Log, and Operation
Log satisfy both of the following conditions, then CSV files may not be created correctly.

- Either batch output or real time output is outputted to external memory device at the
same time.

- Specify File Name by Value of Device Address function is used.

If a value greater than or equal to 2 dots is selected in "Line Size" in Line Chart (Device
Address Display) and deletion is executed, then the polyline do not get completely
deleted.

<Application Software>

Bugs Fixed

The following problems have been fixed:

4

If the setting for Windows font in "State" tab, which is in the Properties dialog box of
Multi-State Lamp, is changed from"Set" button, then "Style", "Size", and "Character Set"
do not get saved.

If device addresses or tags that contain square brackets ("[", "]") are used in script, then
changing Product Series deletes strings in between the square brackets.

If ASCII code is inputted in "Name" text box of "Y-Axis" tab, which is in the Properties
dialog box of Line Chart, and project is saved, closed, and reopened, then inputted string
do not get displayed properly.

If "Device Address Display" is selected from "Chart Type" drop down list in "General" tab,

which is in the Properties dialog box of Line Chart, the following problems occur.

- When project file is downloaded to display, line did not get drawn even if the bit 0
value of device address, which is set in "Reference Device Address" text box, is
changed from 0 to 1. Project file prior to download had External Device Address set
to "Reference Device Address" text box of "Y-Axis" tab.

- When project file is downloaded to display, line size did not change even if the value
in device address, which is set in "Line Size" text box, is changed. Project file prior to
download had "Line Type" radio button set to "Value" and "Line Size" radio button
set to "Device Address".

- When project file is downloaded to display, line size did not change even if the value
in device address, which is set in "Line Type" text box, is changed. Project file prior
to download had "Line Type" radio button set to "Device Address" and "Line Size" set
to "Value".

When a project file that satisfies the following conditions is opened using WindO/I-NV4



Ver.1.11.1, Alarm Log Settings, Operation Log Settings, and Preventive Maintenance
Settings become invalid.

"Device Address" radio button is selected in "Trigger Condition" group box in
"Operation Log Settings" dialog box.

- The project is created using WindO/I-NV4 Ver.1.9.2 or older.

» Moving and overwriting an analog module which is already configured to another slot on
Module Configuration Editor may change the parameters of the analog module settings.



WindO/I-NV4 Ver.1.11.1

<Runtime System Software>

The following functions have been introduced.

4

v v v v Vv

WindO/I-NV4 now supports HG5G/4G/3G/2G-V.

- 2 channel video interface available.

- BACnet communication is supported.

- Japanese can be input in Character Input.

- Analog I/O module is supported.

- Range of Device Address of DMLINK communication driver extended.
WindO/I-NV4 now supports HG1P.

- In User Communication, Inching function has been supported.

USB interface mini-B of MICRO/I is fixed to Full-Speed and improved to communicate
stably with a personal computer.
WindO/I-NV4 now supports Target IP Address Searching.

User can now choose whether to clear or not clear Data Log when downloading a project
data to the MICRO/I.

Windows Font now can be used in Numerical input and Numerical display.

When out of range value is inputted in the Numerical Input, minimum value or maximum
value that is closer to the inputted value will be displayed.

Data Log can now be stored on external memory so that a lager quantity of data can be
displayed on Line Chart.

Value of a bit device can now be obtained in Data Log function.

"Store Status of Sampling" in Data Log Function can now be used when "Sampling
Method" is set to "Always".

4 Y-axes can now be set at the same time in Line Chart.

User can now choose to display the line of his/her choice in Line Chart.

Style of line can now be set in Line Chart (Device Address Display).

The choice of reverse axis now is added in Bar Chart.

The choice of displaying Processing Error, when the value of Minimum, Maximum or
Range is Invalid, is now added to Bar Chart, Line Chart and Meter.

Improved timing to send request command from MICRO/ in Hitachi Industrial Equipment
Systems EH driver.

Bugs Fixed

The following problems have been fixed:

4

»

The security setting of Parts and Screen is effective even if "Use Security functions" is
disabled.

If the following communication drivers are used in Simulator Function, the values of
External Device Addresses cannot be changed.

-~ MICROSmart (FC6A)(RS232C/485)



- MICROSmart (FC6A)(Ethernet)

The background color of Message Display is not updated when characters are changed
according to the value of device addresses.

The string of the pressed switch on the password screen sometimes may not be entered
properly. This occurs only in HG1G.

When the total size of headers and labels in the E-mail function exceeds 300 bytes while
attaching Data Log files, the labels of the attachment become invalid.

MICRO/I cannot make connection with the mail server when "Specify General setting and
Authentication setting by Value of Device Address" is checked in E-mail function, and
"Storage Method of String Data" in "System" is set to "from lower byte".

If an NMF image, which contains "paint" and "character" object, gets resized, it does not
get displayed in the correct position.

If the installation setting is set other than "Horizontal" and Object is placed on the top
layer on popup screen, the transparency setting of popup screen becomes invalid.

<Application Software>

The following functions have been introduced.

4
4

The properties for new features of the Runtime System Software are added.

"Email (Alphabet)", "Email (Number & Sign)" and "Clock Settings" are added to Standard
Keypad.

Default settings of Windows font can be changed on "WindO/I-NV4 Options" dialog box.

Only available items are listed in "Default Showing Page" drop-down list on "Web Server"
tab of "Project Settings" dialog box.

Results of error checks when "Download" button is pressed are displayed on
"Information" window.

Pages of "HMI Special Relay (LSM) ", "HMI Special Data Register (LSD) ", and "System
Area" in help file can be opened directly from help menu of ribbon.

Print function now displays progress between pressing button and opening "Print
Preview", "Print", or "Save As" dialog box.

Print function now has the following function.

- Displays progress between pressing button and opening "Print Preview", "Print", or
"Save As" dialog box.

Print function now supports the following functions.

- New functions of WindO/I-NV4 Ver.1.10.0 and Ver.1.11.1

- "External Memory Device" tab and "Printing" tab on "Alarm Log Settings" dialog box

- "External Memory Device" tab on "Individual Settings" dialog box of "Data Log
Settings" dialog box

- "External Memory Device" tab on "Operation Log Settings" dialog box

- "Preventive Maintenance" dialog box

- "Attach Files" dialog box of "E-mail Settings" dialog box

- "Sound Settings" dialog box

- "Multimedia" dialog box

- "Options" tab of "Security" dialog box



- "Web Page" tab of "Security Settings" dialog box

- Group settings on "Text Manager" dialog box

- "Script Manager" dialog box

- "Tag Editor" window

Alarm Log settings can be exported and imported.

IP addresses of MICRO/Is that are connected to LAN can be searched.
The following functions are added to Script function.

- Multiple lines can be commented and uncommented at once.

- Multiple scripts can be exported and imported at once on "Script Manager" dialog
box.

"Increment Bit Number" function is added to "Editing" group of ribbon.
"Script Debugger" function is added to Simulator.

Center point can be specified from the preview of picture in "Dynamic Rotation" dialog
box of Picture Display.

The following items are added to Screens Monitor, Custom Monitor and Batch Monitor as
Data Type of string.

- String(European)

- String(Japanese)

- String(Chinese)

- String(Taiwanese)

- String(Korean)

- String(Central European)

- String(Baltic)

- String(Cyrillic)

Performance for controls such as copy and pasting, selecting, drag and dropping,
multiple Drawings and Parts is improved.

The following usability improvements are made.

- In "Project Settings" dialog box, the layout of "User Communication" tab is improved.

- In "Message" tab of Message Switching Display, when blank cell of "Message" column
of "Settings" list box is double-clicked with "Use Text Manager" check box ON, the
previously set Text ID is displayed in "Text Manager" dialog box.

- When Device Address is configured in "Tag Editor" dialog box opened from "..."
button, settings, for instance, for "Target" drop-down list in "Tag Editor" window of
Workspace, are kept saved.

- "E-mail Settings" node and "E-mail Address Book" node, "File Transfer" node and
"FTP Server Manager" node, "Global Script" node and "Script Manager" node are
placed next to each other.

- In "Script Editor" dialog box, contents of "Format" text box displayed when
"Arithmetic Operators" is selected in "Category" list box are improved.

- "Category" list box item on "Script Editor" dialog box are rearranged according to
WindO/I-NV4 User's Manual.

- Default width and height of "Simulator" window are widened to help notify user the
screen area's boundaries.

- If "Use Custom Settings" check box is OFF, minimum setting, which is needed to



rotate picture, can be understood easily by adding "Use Custom Settings" check box
to "Dynamic Rotation" check box of Picture Display.

- In "Change Product Series" dialog box, default setting of "Set Conversion Option" is
changed to "Zooming Conversion" radio button.

- When creating new Base Screen or Popup Screen, default "Background Color" drop-
down list on property dialog box displays the previously set color.

- If HG1G is selected as Product Series names of each interface, which are located in
"Interface Configuration" list box of "Communication Interface" tab on "Project
Settings" dialog box, are matched with the printing of MICRO/I.

- When new project is created, "External Device Communication 1" is assigned to
corresponding interface in "Interface Configuration" list box of "Communication
Interface" tab on "Project Settings" dialog box.

- If font used in project does not exist in PC while opening a project, warning message
appears and notifies user that the font will be changed.

Bugs Fixed

The following problems have been fixed:

»

If the text in "Text Manager" dialog box is exported and re-imported, an error message

may be displayed and importing may not be completed properly.

In the following Parts, if a line is selected in "Settings" list, another line may be focused.

- Message Switching Display

- Line Chart

In Goto Screen Button, Multi-Button, Goto Screen Command or Multi-Command, if "Open

User Account Setting Screen" is selected as "Action Mode" and both of the following

conditions are satisfied, buttons on "User Account Setting Screen" does not work

properly.

- In "Configure Processing Area of User Account Setting Screen" dialog box, Device
Address other than "LDR 0000" is set to "Top Device Address".

- Tag Name is assigned to at least one of device addresses from "LDR 0000" to "LDR
0151".

If the following Communication Driver is selected and Tag Name is assigned to

"WI(Input(Word))", "WQ(Output(Word))", "I(Input(Bit))" or "Q(Output(Bit))" in project

which is created by WindO/I-NV4 English or Chinese Edition, when the project is opened

and saved in WindO/I-NV4 Japanese Edition, even if the assigned Tag Name is deleted,

the same Tag Name cannot be set to another Device Address.

- MICROSmart(FC6A)(RS232C/485)

- MICROSmart(FC6A)(Ethernet)

If the following Communication Driver is selected and Tag Name is assigned to Device

Address of "D(Data Register)" in project which is created by WindO/I-NV4 Ver.1.5.0 or

earlier, the Tag Name cannot be changed after converting project with WindO/I-NV4

Ver.1.6.0 or later.

- OpenNet,MicroSmart,SmartAXIS Pro/Lite(RS232C/485)
- OpenNet,MICROSmart,SmartAXIS Pro/Lite(Ethernet)

In "Communication Interface" tab of "Project Setting" dialog box, the following problems
are occurred in "Interface Settings".



- In HG4G/3G(Multimedia), HG4G/HG3G or HG2G-5F project, if "User Communication"
is selected to serial interface, the "Flow Control" drop-down list is enabled even
though flow control is not supported by MICRO/I.

- In HG2G-5T, HG1G project, if "Sub Host Communication" is selected to serial
interface, "Flow Control" drop-down list is disabled even though flow control is
supported by MICRO/I.

In Picture Display, if External Device Address is set to "Source Device Address" in
"Dynamic Rotation" dialog box and the project is downloaded to MICRO/I, the picture
may not be rotated.

If multiple Picture and Parts are copied and pasted, the editing screen may not be
displayed properly.

In "Security" dialog box, if the security group of "Administrator" is not assigned to No.1
and "Use Security functions" check box is OFF, the project cannot be opened after the
project is saved and closed.

In "Security" dialog box, if the security group of "Administrator" is assigned to No.1 and
others, and "Use Security functions" check box is OFF, the project can be opened even if
the user name and password for the others are entered in "Check User Name and
Password" dialog box which is displayed when the project is opened.

If "Display" column of "Security" tab on properties dialog box for Parts is changed and
"Active User" drop-down list of "View" tab in ribbon is changed, display condition of the
Parts is not correct on Editing Window.

In "Change Product Series" dialog box, if "Zooming Conversion" radio button is selected
and Product Series is changed, the following problems occur.

- Values of "X" and "Y" for "Center Point" on "Dynamic Rotation" dialog box of Picture
Display is not converted according to screen size.

- In properties dialog box for Drawings or Parts, if "Windows" is set in "Font" drop-
down list, value of "Size" may become larger or smaller than the expected value.

- In "Text Manager" dialog box, if "Windows" is set in drop-down list of font setting,
value of "Size" may become larger or smaller than the expected value.

- In the Properties of Text dialog box, if "Windows" is set as "Font" drop-down list and
"Use Text Area" check box is OFF, values for "Width" and "Height" spin box become
larger than the expected value.

- In the Properties of Text dialog box, while the following three conditions are met,
values of "Width" and "Height" spin box become larger than the expected value.

*  "Text Manager" checkbox is set to ON in the Properties of Text dialog box.

*  Font drop-down setting sets "Windows" text ID in the Text Manager to "Text ID"
spin box in the Properties of Text dialog box.

*  "Use Text Area" checkbox is set to ON in the Properties of Text dialog box.
If an object, which satisfies following conditions, gets placed on a screen saved, closed,
and reopened, that same screen gets deleted.
"Windows" is set in "Font" drop-down list, and more than 1 is set in "Character Pitch"
and "Space Between Lines" spin boxes.
- Only line break is set in "Text" text box.
If the following 2 conditions for "Text Manager" dialog box are met, user can not reopen
project after inputting "Text ID" spin box in object's property dialog box and saving
project.



"Windows" is set in "Font" drop-down list, and more than 1 is set in values of
"Character Pitch" and "Space Between Lines" spin boxes.

- Only line break is set in "Text" text box.
» If a NV Metafile which includes Text or Fill is used with Drawings or Parts, coordinates of
the Text or Fill is not adjusted according to size of the Drawings or the Parts.

» In Properties of Potentiometer dialog box, if "UBIN32(D)" is set in "Data Type" drop-
down list and "2147483648 to 4294967295" is set in "Minimum" or "Maximum" spin box,
the project cannot be downloaded.



WindO/I-NV4 Ver.1.9.2

<Runtime System Software>

Bugs Fixed
The following problems have been fixed:

» When running over one month without any change in the screen display, the screen
display will not update even after operating the screen again.

» In the Data Log Function, while using External Device Addresses for "Monitor Count of
Writings to Data Storage Area" or "Monitor % Space Used in Data Storage Area", if the

count of sampling times exceeds over 32767 times, the screen scan will be delayed and
the touch panel will not respond.

<Application Software>

Bugs Fixed
The following problems have been fixed:

» When the OS of PC is Windows 10 version "1809", opening "Save As" dialog box freezes
WindO/I-NV4.



WindO/I-NV4 Ver.1.9.1

<Runtime System Software>

Bugs Fixed

The following problems have been fixed:

4

If Modbus RTU Master Driver is used, the function of "Ignore communication errors and
continue operation" does not work.

If data is received from Communication Interface during start-up, MICRO/I cannot
communication with external devices.

<Application Software>

Bugs Fixed

The following problems have been fixed:

4

If NV Metafile of Polyline or Polygon is used with Picture of Drawings or Picture of any
Parts, view on Editing Window is different from view on display.

If WindO/I-NV2 project which contained picture of transparent color is opened with
WindO/I-NV4, transparent color may be displayed with magenta color.

If NV Metafile is imported for several times, Drawings on Editing Window may be deleted.

If project file is opened, the size of NV Metafile on the popped up message in "Picture
Manager" dialog box is displayed 1 dot smaller.

If NV Metafile which contained Polyline or Polygon is imported in "Picture Manager"
dialog box, the size of NV Metafile becomes 1 dot smaller.

If Undo function is executed after NV Metafile is imported, the previous operation before
the import is canceled.

If the grouped objects which contained Fill object is copied and pasted, the operation
cannot be canceled with Undo function.

If NV Metafile is imported, it is grouped even if object is 1.

If Numerical Input, Numerical Display or Line Chart is grouped, controls of the "Range"

group of "Data Over" tab in property dialog box are not displayed properly.

If overlaying base screen which "Text Manager Color" set to text color in property dialog

box of part objects, the following problems may happen.

- X mark is displayed on Editing Window of base screen.

- In parts of buttons, characters set to "Text" text box of "Registration Text" tab are not
displayed on Editing Window.

Text which is registered in "Text Manager" may not be displayed on MICRO/I which

downloaded project or Simulator.

If a project which created by WindO/I-NV2 is uploaded from MICRO/I with WindO/I-NV4,

the following problems are occurred.

- Conversion from WindO/I-NV2 project to WindO/I-NV4 project fails.



- If a project which failed conversion is downloaded and uploaded, "Project Settings"
dialog box cannot be opened.

In "Format" tab of Message Display and Message Switching Display, value of "Speed" spin

box of scroll is reset to default value every time when the property dialog box is opened.

If "Satisfy the condition" or "While satisfying the condition" is selected as "Trigger Type"

of trigger Condition on the property dialog box of part objects, "E-mail settings" dialog

box or "File Transfer Settings" dialog box and the following trigger condition is set, even

though it is a correct condition, an error message is displayed.

- The condition has both bit Device Address and word Device Address.

- The condition has only number.

When project is opened, "Check User Name and Password" dialog box may be displayed

with project which does not require input of password.

If "Cancel" button is pressed in property dialog box of part objects, the message for save

is displayed when the "Download" button is pressed even though settings have not been

changed.

In "Script Editor" dialog box, if "//" is written at the end of line, an error message is

displayed and project cannot be opened.

If "External Device Name" is changed from default value on "Communication Driver
Network" tab of "Project Settings" dialog box and External Device Address corresponding
to the External Device Name is used to the trigger condition, even though it is a correct
condition, an error message is displayed and project cannot be downloaded.

If one of the following conditions is satisfied, Simulator crashes.

- In Numerical Display, "Flash" is OFF in "Format" Tab and "Flash" is ON in "Data Over"
Tab.

- In Bar Chart, any data is not set.
- In Potentiometer, "Minimum" and "Maximum" are set to the same setting.
- In Shape, "Pattern" is set to gradation and "W(Width)" and "H(Height)" are set to 1.



WindO/I-NV4 Ver.1.9.0

<Runtime System Software>

The following functions have been introduced.

4
4

Rotation function was added to Picture Display.

The communication processes of FTP client function and FTP server function are
improved, and the kind of connectable devices are increased.

In Hitachi Industrial Equipment Systems EH Driver, the communication process is
improved when PLC becomes busy state.

Bugs Fixed

The following problems have been fixed:

»

In E-mail function, the invalid characters are added to the subject when "ASCII" is
selected as "Character Set" setting.

In the Password screen of the System Mode, User name and Password are not displayed
correctly. This is applicable to HG2G-5T and HG1G.

The External Device ID is not displayed in the message which displayed when a
communication error occurred. This is applicable to HG2G-5T and HG1G.

In Line Chart, the line which displayed on the chart may be incorrect at the initial display.

<Application Software>

The following functions have been introduced.

4
4

The properties for new features of the Runtime System Software are added.

Following usability improvements for "Replace" dialog box are made.

- The layout of "Replace" dialog box is changed to tab form.

- Replace a word device bit is supported.

MICROSmart (FC6A) (RS232C / 485) and MICROSmart (FC6A) (Ethernet) are added as

Communication Drivers for FC6A and the following improvements are made.

- Symbols of Input(Bit), Output(Bit), Input(Word), and Output(Word) in Japanese
Edition of WindO/I-NV4 are unified with manual.

- Index Register is supported.

Output items of Object List can be selected in Print function.

Size of screen for simulator can be expanded to 200%.

When Tag Names and comments are imported, unsupported Device Addresses are

skipped.

Title of screen can be edited easily on "Project" window.

When the data type is changed, the value of setting which depends on the data type is

kept.

The size of Editing Window of WindO/I-NV4 and the display size of MICRO/I were

different by 1 dot, so these sizes are aligned.



»

In the import function of "Picture Manager" dialog box, it supports importing images
which is larger than the screen size.

In "Communication Driver Network" tab on "Project Settings" dialog box, default value of
Slave Number for Serial 1:N Communication Driver is improved.

Size of "Protocol Manager" dialog box can be changed.

Bugs Fixed

The following problems have been fixed:

»

If Preview function is executed when the overlaid screen does not exist in project, base

screen is not displayed properly on preview.

Replace function cannot be used even if Device Address is configured on "Project

Settings" dialog box.

Error check for the number of External Device Address on one screen is not properly.

After string is copied and pasted to Tag Name for bit number of Word Device on "Tag

Editor" window, the following problems are occurred.

- After Tag Name is changed and project is saved, if project file is opened, Tag Name
is reverted.

- Tag Name is overlapped.

- If Device Address which the above problems are occurred is configured with Trigger
Condition or Script, project file is broken.

If project file which contained Alarm Log Display is created with WindO/I-NV2 of Chinese
version and the project file is opened with WindO/I-NV4, screen is not restored properly.
If the always updated object is placed on screen and Simulator is launched, text box to
input the screen number cannot be edited.

If Device Addresses are registered with Data Type of 32 bit to Data Log function and
project is converted from Ver.1.6.0 or earlier version to Ver.1.7.0 or later version, Device
Addresses are not restored properly.

If "Script Manager" dialog box is opened from "Global Script" dialog box or property
dialog box of Script Command and "Script Manager" dialog box is closed with "Close"
button, value of "Script ID" spin box is changed to 1 automatically.

When "Screen Monitor" dialog box, "Custom Monitor" dialog box, "Batch Monitor" dialog
box or "External Devices Monitor" dialog box is opened, it may be displayed outside of
PC's display(s) and it causes to seem that WindO/I-NV4 is frozen.

Copy and paste is not running with object which configured text ID which text is blank.
After External Device Address is registered in Custom Monitor function, if External Device
is changed to another External Device and project is saved, the project file may not be
able to be opened.

Characters cannot be converted on "Script Manager" dialog box while monitor is
executing.

The Settings of the "WindO/I-NV4 Options" dialog box may not be enabled or saved.



WindO/I-NV4 Ver.1.8.0

<Runtime System Software>
The following functions have been introduced.

» Security function is enhanced.
- Security setting can be changed on MICRO/I.
- In function to limit Display or Operation, two or more security groups can be set.
- Administrator, Operator, and Reader can be set to two or more users as the security
groups.
- The privilege to upload or download project data can be set to security groups that
you create.
- The user name which is logging in to the MICRO/I can be stored to Device Address.
» Password authentication with MICRO/I is improved to require entering user name.
» In "Image Type" of Chart, "None" can be selected.

» In Selector switch, the function to change the position of the knob with the values of
Device Addresses was added.

» When downloading a ZNV project file using Key Button or file manager in system mode,
whether to clear Keep Device can be selected.

» In File Transfer function, supports file copy between external memory devices.

» In Character Input, function to write NULL terminating character (0x00) as the end of
string when string of maximum digits is input is added.

» In Character Input, function to write NULL (0x00) after the end of the string is added.

» Text alignment of Numerical Input and Character Input is adjusted depending on the
length of the displayed strings.

» If using Modbus RTU Master Driver, the slave number for the target can be changed
while the MICRO/I is running.

» Web server function is improved.
- Improved display speed of Custom Web Page.

- The display of remote monitoring screen and remote operation screen is updated
automatically when MICRO/I is reconnected with network.

Bugs Fixed
The following problems have been fixed:

» O/I Link Slave Communication does not work when Modbus RTU Slave, S7-200(PPI) or
S7-MPI is used as Communication Driver.

» Maintenance port does not work when Modbus RTU Slave and O/I Link Slave are used as
Communication Driver at the same time.

» If invalid project is downloaded to MICRO/I, MICRO/I may be reset.

» In E-mail function, MICRO/I may not be able to connect with the e-mail server when
Authentication setting is specified by value of Device Address.



<Application Software>

The following functions have been introduced.

v v v v Vv

The properties for new features of the Runtime System Software are added.
Simulator function is supported.

Print function is supported.

Performance of opening project and saving project is improved.

Following usability improvements are made.

- In "Tag Editor" opened from "..." button, default value of "Target" drop-down list and
SO on is improved.

- Icons on Ribbon - "View" tab - "Workspace" group are rearranged.

- Appearance on "Project Window" when errors are found before downloading project
is improved.

- Tabs on "Project Settings" dialog box are displayed in multi-line.

- Default value of "Number of Stored Data for Data Log per Device Address" in "Data
Storage Area Management" dialog box is changed to 1024.

Bugs Fixed

The following problems have been fixed:

4

In Message Display, when "Align Text Horizontal" is "Center-Left" or "Left-Right", and its
message contains value of Device Address, display position of the message is invalid.

After "Download Standard Fonts and Optional Fonts" check box is ON and downloading is
performed, keep Device Addresses are cleared regardless of state of "Clear Keep
Devices" check box.

When the Communication Driver is "Logix Native Tag (Ethernet)", result of reading and
writing to bit numbers of DINT tags may be invalid.

WindO/I-NV4 does not run when configuration file for "IP Address Manager" is invalid.
After removing items from "Quick Access Toolbar", keyboard input may not be able to do
on WindO/I-NV4.

When project is downloaded, files may not be downloaded to External Memory.

In "Data Log Settings" - "Individual Settings" dialog box - "Data" tab, Allen-Bradley
format Device Addresses may not be set correctly.

When Bar Chart which satisfies the following conditions exists, Editing Window cannot be
used.

- In "Data" tab, gradation pattern is set.

- Size of object is small.

After changing Communication Driver, correct used count may not be displayed on
"Used" column of "Tag Editor".

In "Project Settings" dialog box - "Communication Driver" tab, if "External Devices" is
selected, values of "Expansion Settings" in "Communication Driver Network" tab are
Cleared.

In "Text" of Drawings, when "Use Text Area" check box is OFF, size of the text on Editing
Window or value of "W", "H" may be invalid.

Warning message does not be displayed even if project is downloaded with "Custom Web
Page Files" check box is ON and External Memory is not inserted in MICRO/I.



In "Project Settings" dialog box - "Communication Driver" tab, the following invalid
combinations of Communication Drivers can be configured.

Modbus TCP Server and DM LINK Ethernet(UDP)

Modbus RTU Slave and DM LINK Ethernet(UDP)

- DM LINK(1:1) and DM LINK Ethernet(UDP)

DM LINK(1:N) and DM LINK Ethernet(UDP)

In Alarm List Display, dotted lines indicate display area may not be displayed.

Bar Chart and Pie Chart cannot be duplicated correctly if "Enable Increment Address
Number" check box is ON.

In "Script Editor" dialog box, Tag Names may not be displayed correctly.

For some of dialog boxes, when the dialog box is opened, it may be displayed outside of
PC’s display(s) and it causes to seem that WindO/I-NV4 is frozen.

Selection state of part objects may be invalid after executing "Undo" or "Redo".

When "Duplicate Screen" is opened from "Project Window", default selected item may
not be correct.

<Web Page Editor>

Bugs Fixed

The following problems have been fixed:

4

When you enter "transparent” in the FillStyle dialog box, nothing may be shown on the
dialog box.

An error message is displayed when web page containing a multi-state lamp is shown
and an image associated to the multi-state lamp does not exist.

When an animation GIF image containing transparent color is specified, the animation is
not displayed properly.

Font size may not be adjusted correctly when both "Adjust to the browser width when
runtime" and "Adjust to the browser height when runtime" are enabled for the layer size
settings.

When a tab component is placed inside another tab component, the font size of the tab
component placed inside may not be adjusted.

When properties of a component placed inside a tab component are changed, Redo
operation does not function.

When grouped components are grouped with additional components and placed inside a
tab component, the group ID of those components are changed.

When setFillStyle() is called in JavaScript of Label component, background color of the
Label component may not be changed.

When a trend component and a Text Input component are linked, labels of Y-axis of the
trend component may not be displayed properly.

When the data for Linel of a Trend component is not updated, Snapshots are not saved
properly.

If a font containing space character such as ‘MS Gothic’ is specified in the Font property,
the specified font type may not be selected when the Font property is opened again.
When positons of Label components contain digits after the decimal point, unnecessary
lines may be displayed on the extended line of the label frame line.



<Symbol Factory>
The following improvements have been added.
» The launching speed of Symbol Factory is improved.

Bugs Fixed
The following problems have been fixed:

» In "Set Preview Size" dialog box, a part of string for "Apply these settings globally to all
categories" check box is not displayed.

» In Basic mode, the deleted images cannot be reverted by "Undo Delete" button on the
ribbon.



WindO/I-NV4 Ver.1.7 .1

<Application Software>

Bugs Fixed
The following problems have been fixed:

» When WindO/I-NV4 is launched with a user account which does not have administrator
privileges and project file is opened, if internal error is occurred with tag editor, the
following problems may be occurred.

- WindO/I-NV4 crashes.
- An error message is displayed and the project file cannot be opened.
- The screens which saved in the project file cannot be displayed.

» If "External Device Name" is changed from default value on "Communication Driver
Network" tab of "Project Settings" dialog box, the following problems are occurred.

- External Device Address is configured as "Top Device Address" of Data Log function,
"Data Log Settings" dialog box cannot be closed by clicking "OK" button.

- If old project file which configured above setting is converted by WindO/I-NV4
Version 1.7.0, "Top Device Address" setting is deleted on "Data" tab of "Individual
Settings" dialog box of Data Log function.



WindO/I-NV4 Ver.1.7.0

<Runtime System Software>

The following functions have been introduced.

4

v v v v Vv

4

Data Log function is extended.

"While satisfying the condition of writing to data storage area" is added to sampling
method.

- Any Device Address can be specified as output data.
- "String(S)" (string) is added to data type of output data.
- Output items for header of CSV file can be selected.

The number of External Device Address which can be used on one screen is expanded to
512 points.

Display area of text for parts placed on the top layer is expanded.

In E-mail function, SMTPs is supported.

In E-mail function and FTP client function, Host name can be specified as server.
In "Ethernet" settings of MICRO/I, DNS server can be specified.

The maximum number of Transmission commands and Receive commands per Protocol
in User Communication is expanded to 255.

For "Monitor Sampling Count" in "Data Log Settings" and "Monitor Number of Stored
Data" in "Operation Log Settings", the behaviors are reconsidered.

Validation of the overlapped port humber for maintenance communication is enhanced.
The following Communication Driver is supported.

- GE Fanuc Automation SNP

The maximum number of multiple Read/Write setting is supported with the following
Communication Drivers.

- Modbus RTU Master

- Modbus RTU ASCII

- Modbus TCP Client

The displayed message when a communication error occurred is improved.

Bugs Fixed

The following problems have been fixed:

4

4

4

If the External Device Address is inserted in the body text of e-mail, wrong value may be
inserted.

If the maximum number of External Device Address is set on the base screen, MICRO/I
cannot communicate with the external devices properly.

When the 1:1 Communication Driver and the 1:N Communication Driver are used at the
same time, the value of External Device Addresses may not be updated.

In Web server function, if the MICRO/I Installation direction is set to Horizontal (Rotate
180°), when the sub screen is moved by remote operation, the sub screen moves to a
different position from the set coordinates.



<Application Software>

The following functions have been introduced.

4

The properties for new feature of the Runtime System Software are added.
And the captions of the properties for other features are reconsidered.

Bugs Fixed

The following problems have been fixed:

4

If "Internal Memory" is selected as "Access to" setting with Recipe function, Recipe
function may not be running properly.

If "Internal Memory" is selected as "Access to" setting with Recipe function and a same
string is configured as "File Name" setting of multiple channels, the following problems
are occurred when project file is opened after saving project.

- If "Enable" is selected with each channel, all values of "Data List" becomes same
value.
- If "Enable" and "Disable" is configured with each channel, all values of "Data List"
becomes 0.
If project file of WindO/I-NV2 of which pictures are registered in Picture Manager is
opened with WindO/I-NV4, project file may not be able to be opened.
If WindO/I-NV4 is relaunched after registering group on ribbon to Quick Access Toolbar, a
part of GUI for group which registered in Quick Access Toolbar is not displayed.
If Tag Name of Device Address used in "Script Editor" dialog box contains a double-byte
character and single-byte character and last character is hexadecimal, error check of
"Script Editor" dialog box is not running.
If project is saved after strings is configured on "Multi-Language String Editor" dialog box
of Web Page Editor function, settings in "Multi-Language String Editor" is deleted when
project file is opened.
In icon of base/popup screen on "Project" window, the screen icon with the incorrect
setting may be blue or the screen icon with the correct setting may be displayed in red.
If the version of the project downloaded to MICRO/I is newer than the version of
WindO/I-NV4 used for uploading the project, WindO/I-NV4 crashes when project is
uploaded.
If "Screens" group of "View" tab in ribbon is registered to Quick Access Tool Bar and the
project is opened, WindO/I-NV4 crashes.
If "Screens" group of "View" tab in ribbon is registered to Quick Access Tool Bar, the
"ON/OFF" icon corresponding to the state of Parts is not displayed.
When the following textboxes are added to Quick Access Tool Bar and characters other
than numbers are entered in it, WindO/I-NV4 crashes.
"View" - "Screen" — "State" text box
"Online" - "Monitors" - "Screen Number" text box
In Preview function, if Alarm List Display of which message of Windows font is configured
is displayed, the unnecessary dotted rectangle is displayed.
In "E-mail Settings" dialog box, if project is saved after "(tab)" is entered in the "body"
text box, the "(tab)" is changed to [?] (Question) when the project file is opened.
When "Expression of Device Address Format" is "Allen-Bradley" and "Bit Number Symbol"



is "Dash", the following Device Address cannot be configured.
- Allen-Bradley - MicroLogix/SLC 500 (Full Duplex)
*  WI (Input (Word))
* WO (Output (Word))
- Allen-Bradley - SLC 500 (Half Duplex)
* WI (Input (Word))
* WO (Output (Word))
- Allen-Bradley - Logix Controllers (Ethernet)
*  SWI (SLC/MicroLogix Input (Word))
*  SWO (SLC/MicroLogix Output (Word))

When "Expression of Device Address Format" is "Allen-Bradley", the following Device
Address cannot be configured.
- Allen-Bradley - PLC-5(Half Duplex)

* WI (Input(Word))

* WO (Output(Word))
When "Expression of Device Address Format" is "Allen-Bradley", even if "Expression of
Device Address Format" is changed from "Dash" to "dot", the delimiter of Device Address
is not changed.
After a part on screen is copied and pasted when "Increment Address" is enabled, if
"Trigger Condition" of the copied part is edited with Object List, the configured Device
Address of "Trigger Condition" of source for the copied part is changed.
If a part on screen is copied and pasted when "Address Adjustment" is enabled, the
configured Device Address in "Trigger Condition" of source for the copied part is
changed.
In property dialog box of Volume, if a specific number of characters are set in "Part
Name" text box on "General" tab and the project is downloaded to MICRO/I, MICRO/I
keeps resetting.
If there are many parts of which Windows font is configured in project, the base screen
or sub screen may not be displayed when the project is opened.
In "Command Settings" dialog box for user communication setting, an error message is

displayed even though value of "Transmission Wait" setting is less than value of "Period"
setting for "Fixed Period".
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<Runtime System Software>

The following functions have been introduced.

4

4

Additional supported Communication Drivers.

- Hitachi Industrial Equipment Systems EH

- JTEKT (Toyoda) TOYOPUC(Ethernet)

The usable Device Address ranges of the following IDEC Drivers are extended.

- IDEC OpenNet,MICROSmart,SmartAXIS Pro/Lite(RS232C/485)

- IDEC OpenNet,MICROSmart,SmartAXIS Pro/Lite(Ethernet)

PLC Program Transfer Function supports IDEC MICROSmart FC6A Plus.

Pass-Through Function supports IDEC MICROSmart FC6A Plus.

Enhance the verification of the overlapped port number for maintenance communication.

Bugs Fixed

The following problems have been fixed:

4

The number of lines which is shown on Alarm Log Display may be different between
WindO/I-NV4 and MICRO/I.

In Device Monitor of MICRO/I, Device Address is not automatically incremented if the
External Device ID is not 0.

In Message Switching Display, when display color is changed while the message is
scrolling, the message does not scroll properly.

In Pie Chart, if it does not contain any channel data, MICRO/I may be reset after the
project is downloaded.

MICRO/I may not be able to communicate with USB barcode reader even if it is
connected with the MICRO/I.

If Keyence KV (Ethernet) is selected as Communication Driver, and MICRO/I write value
to the following devices, wrong value is written to the PLC.

Timer (Current Value)
Timer (Preset Value)

- Counter (Current Value)
Counter (Preset Value)

<Application Software>

The following functions have been introduced.

»

Symbol Factory included in WindO/I-NV4 is updated.

Bugs Fixed

The following problems have been fixed:



If the file name of the project created by WindO/I-NV4 Ver.1.1.0 is changed, the project
cannot be opened by WindO/I-NV4 Ver.1.3.0 or newer version.

In "Project Settings" dialog box, once confirmation message or error message is
displayed by pressing "OK" button, even if "Cancel" button is pressed in "Project
Settings" dialog box, the configuration of the dialog box may not be changed back.

If Tag Name contains "} or " A", it cannot be used in "Trigger Condition".

In Tag Editor, if the same Tag Name is assigned to Device Address which "Target" is

different, the following problems happen.

- If the same Tag Names are used in the setting of Part Object or Configuration, the
different Device Addresses are changed to the same Device Address when the project
file is reopened.

- Even if the Tag Name is deleted, the Tag Name is displayed after reopening the
project file.

In Word Button, if both of the following conditions are satisfied, the decimal part in

"Value" text box is removed after reopening the project file.

"Add", "Sub", "Multi", "Div" or "Mod" is selected as "Action Mode"

- "Float32(F)" is selected as "Data Type"

In "E-mail Settings" dialog box, if some specific Japanese character is used in "Body" text

box, the text is corrupted after reopening the dialog box.

If both of the following conditions are satisfied, the following problems happen in the

text box for Device Address.

<Condition>

- In "Setting" of "Communication Driver Network" tab in "Project Settings" dialog box,
more than one "External Device Communication" are configured.

- "External Device Name" is changed from the default.

<Problem>

- When opening an old version of a project with a newer version of WindO/I-NV4,
Device Addresses of External Device in "Trigger Condition", "Input with Arithmetic
Operation" and "Display with Arithmetic Operation" are deleted.

- In "E-mail Settings" dialog box or "E-mail Address Book" dialog box, the dialog box
cannot be closed by error message even though proper Device Address of External
device is assigned.

- When "Undo" or "Redo" is used, the Device Address which is assigned before the
operation is deleted.
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<Runtime System Software>

The following functions have been introduced.

4
4

Change the message displayed when a communication error occurred.

The function which monitors the connection status between MICRO/I and the external
devices is supported.

The port number for maintenance communication can be set.

"Storage Method of 32-bit Numerical Data" can be set for each external devices.

In the following parts, the function that starting scrolling after displaying message is
supported.

- Message Display

- Message Switching Display

- Alarm List Display

Bugs Fixed

The following problems have been fixed:

4

If there are some e-mail is set "Disable", an e-mail whose condition is not satisfied may
be sent.

If scrolling strings containing newline characters may cause wrong display.

In FTP client function, Incorrect error information may be stored when FTP transmission
fails.

In FTP client function, if the upload target file name is shorter than the upload
destination folder name, the uploaded file name will is changed.

FTP client communication is failure if MICRO/I's FTP Server function is enabled with using
"Specify Target".

<Application Software>

The following functions have been introduced.

4
»

The properties for new features of the Runtime System Software are added.
"Set Conversion Option" is available when changing product series from / to the HG1G.

Bugs Fixed

The following problems have been fixed:

»

If an external character of Japanese is used in "Text" drawing object, the screen is not
displayed properly. In addition, the screen cannot be saved.

If a project is opened from "Project Recovery" dialog box, the following issues happen.

- If the project is created by older software versions, the project may not be converted
to the current software version.



- Even if the project is created by newer software versions, the project can be opened.
In "Text" drawing object, if the following conditions are satisfied, the text area is not
displayed properly.

"Vertical Writing" check box is ON

"Use Text Area" check box is OFF

"Windows" is selected as "Font"
WindO/I-NV2 project may not be opened.
In "Security" dialog box, an error message is not displayed even if "User Name" is blank.

In "Project Settings" dialog box, an error message is not displayed even if the number of
"Port Number" is overlapped.

If "OK" button is pressed in "Communication Driver Extension Settings" dialog box, the
current tab in "Project Settings" dialog box may be changed.

When WindO/I-NV2 project is opened in WindO/I-NV4, part objects and drawing objects
may not be placed on Top Layer.

When the project file is reopened, the flange size of Selector Switch is decreased.

In "Change Product Series" dialog box, even if "Zooming Conversion" is selected as "Set
Conversion Option", "Round Radius" in the property of "Rectangle" is not converted.
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<Runtime System Software>

Bugs Fixed
The following problems have been fixed:

» When "Picture" or "None" is selected as "Image Type" of following part objects, if Text
Color and Plate Color are changed by using "Change Display Colors" or "Flash" function in
Format tab, the background color of the displayed characters becomes Plate Color.

- Numerical Input

- Numerical Display

- Character Input

- Message Display

- Message Switching Display

<Application Software>

Bugs Fixed
The following problems have been fixed:

» Proper items are not displayed in "Project" window.

» In Meter, when "Data Type" is changed in "General" tab, and then the "Value" in "Range"
tab is changed to the same value which was set before changing "Data Type", the screen
which contains the Meter is not displayed properly.

» If "New User Account" or "Change User Account" dialog box is opened from "Security"
dialog box, and then security groups are added, the security groups may not be
displayed in "Web Page" tab in "Security Settings" dialog box.



WindO/I-NV4 Ver.1.4.0

<Runtime System Software>

The following functions have been introduced.

4
4

File Transfer function is supported.

Web Server function is extended.

- Web Page Editor function is supported.

- Default Showing Page setting is supported.

- Security Setting for Custom Web Page is added.

E-mail function is extended.

- Attaching Files is supported.

- The function to insert the value of Device Address is supported.

PLC Program Transfer Function supports IDEC MICROSmart FC6A series.
Pass-Through Function supports IDEC MICROSmart FC6A series.

The MICRO/I supports IDEC MICROSmart FC6A expansion I/O modules. This is
applicable to HG4G/3G and HG2G-5F.

- Input Modules
- Output Modules
- Combination I/O Modules

LSM (HMI Special Internal Relay) and LSD (HMI Special Data Register) support the
functions below.

- Changing the port number of external device.
- Showing the version of MICRO/I system software.

Bugs Fixed

The following problems have been fixed:

»

When "16x16" is selected as "Size" in Format tab of Numerical Input, only half of the
numeric string of the Numerical Input is displayed.

When "None" is selected as "Image type" of Message Switching Display, if the plate color
of Message Switching Display is changed, the background color becomes black.

When uploading and downloading the files at the external device with maintenance
communication via USB, the communication timeout may occur.

In Files Copy function, the root folder is selected as the "Location" of "Destination"”,
MICRO/I makes a folder with no name.

When inserting and pulling the HID class USB device with the USB interface (USB 2)
repeatedly, the communication to the device may be failure. This is applicable to HG2G-
5T and HG1G.

The cursor of the Alarm List Display may be drawn incorrect.

The cursor of the Alarm Log Display automatically moves to the top line.

When drawing characters whose length is exceeding the size of the Alarm List Display,



the background color of the area which is out of the Alarm List Display is drawn with the
plate color of it.

» Switching to the screen which has the parts with using the gradation is slow.

» The FTP Server function returns wrong create time of file and folder. This is applicable
to HG2G-5T and HG1G.

» In the FTP Server function, an access error may occur when moving from the folder
which is specified at login to the lower folder.

» In the FTP Server function, when a file name is changed, the file moves to the root
folder. This is applicable to HG2G-5T and HG1G.

<Application Software>
The following functions have been introduced.

» The properties for new features of the Runtime System Software are added.
» Following usability improvements are made.

- When "Picture Name Settings" dialog box is opened after selecting a picture from
"Symbol Factory", default picture name is now set.

- The default value of "Storage Method" in "Alarm Log Settings" dialog box is changed
to "Rotate".

- The default value of "Action Mode" in "Properties of Bit Button" dialog box is changed
to "Momentary".

- The default value of "Basic / Advanced" in properties dialog box of part objects is
changed to "Advanced".

- The default value of "Data Bits" in "Project Settings" - "Communication Interface" tab
is changed to "8" when "User Communication" is selected as "Function".

- The displayed string in "Ethernet" - "Function" of "Project Settings" - "Communication
Interface" tab is changed to "hyphen", instead of "Not Use".

- The default value of "IP Address" displayed when "Ethernet" is selected in "Project
Settings" - "Communication Interface" tab is changed to "192.168.1.6".

- The caption of "Auto-change IME" check box in "WindO/I-NV4 Options" dialog box is
changed to "Enable Input Method Editor (IME) when entering Device Address".

- "European Large Font" check box in "Project Settings" - "Font Settings" tab is how
selected as default.

» The Device Address of the following part objects now cannot be modified from "Object
List".
- Message Display
- Bart Chart
- Pie Chart

Bugs Fixed
The following problems have been fixed:

» If the following operation is performed when the following conditions are satisfied, blank
item is displayed as "User Name" in "Enter Password" dialog box.

<Condition>



- The password is not configured to the user who is assigned to Administrator group.

- The password is configured to the user who is assigned to Operator group or Reader
group.

<Operation>

- Upload the data from the External Memory.

- Download the data to the External Memory while the MICRO/I is running.

If the password is deleted when "Use Security function" check box is OFF, the deleted

password is displayed as "Confirm Password" in "Change User Account" dialog box.

In "Recipe Setting", if numerical value is copied and pasted to "Data" cell on "Data" tab

in "Individual Settings" dialog box, it is pasted twice.

If Windows font is selected and "tilde" is used as character, it is displayed "Question

mark" in Editing Window and the MICRO/I.

In "E-mail Address Book" dialog box, the E-mail Address which is hidden by "Find"

function is treated as a selected item.

When a Text ID is selected from "Text Manager", if "Text Manager" is closed while

entering a character, the Text ID is not selected.

If "Undo" operation is used for Bar Chart or Pie Chart, an unnecessary error message is

displayed when the project is downloaded.

In the property dialog box of Picture Display, if the following operations are performed,
the configuration is not recovered. In addition, the registered picture cannot be deleted
from Picture Manager.

- Register a picture in "View" tab and close the dialog box by clicking "OK" button, and
then use "Undo" or "Redo"

- Change "Switching Method" in "General" Tab from "Value" to "Bit Number", and then
use "Undo" or "Redo"

If Communication Driver is changed to "Not Use" when "Monitoring communication error

information for each station, individually" is ON, and then the project is downloaded,

MICRO/I keeps resetting.

In "E-mail Settings" dialog box, after configuring E-mail setting for other than No.1, if a

Device Address which is used in "Trigger Condition" is replaced to an invalid Device

Address, the following problems happen.

- Error message for the invalid Device Address is not displayed when "OK" button is
pressed in "E-mail Settings" dialog box

- The Device Address which is configured before executing replace function is displayed
in "E-mail Settings" dialog box

When "Function" is changed in "Communication Interface" tab in "Project Settings" dialog

box, the settings in "O/I Link" tab is change back to the default.

After arranging Selector Switch or Potentiometer on Editing Window, if "Copy and Paste"

or "Duplicate" is used for them, and download the project, the buttons for these Selector

Switch and Potentiometer are not displayed on the MICRO/I.

When WindO/I-NV4 is restarted, the setting value of "Increment Address" is change back

to 0.

When "Parts on the Top Layer" check box is OFF in "Object List", even if the

corresponded drawing objects and part objects are not displayed, they can be selected

by multiple select operations using "Shift" Key or "Ctrl + A" key in "Object List".

If "Security" dialog box is closed by "Cancel" button, and it is opened again, all the



settings are cleared. In addition, if this dialog box is closed by "OK" button, invalid
settings are stored into the project.

If "Internal Memory" is selected as "Access to", and the project is downloaded without
saving, Recipe data is not downloaded.

Mitsubishi Electric MELSEC-FX5U(LINK) Driver and Mitsubishi Electric MELSEC-
FX5U(Ethernet) cannot be used.(This defect only happens in English Edition.)

Even if Device Addresses which are used in the formula of Trigger Condition is replaced
by Replace Function, it does not reflect to the behavior of the MICRO/I.

In "Data Settings" dialog box of User Communication function, the text box which is
displayed when the following item is selected does not support multi line text. In
addition, a line feed cannot be entered by "Enter" key.

- Constant (Character)

- Constant (Hexadecimal)

- Registering Constant (Character)

- Registering Constant (Hexadecimal)



WindO/I-NV4 Ver.1.3.2

<Runtime System Software>
The following functions have been introduced.

» Additional supported Communication Drivers.
- MITSUBISHI MELSEC-FX5U(LINK)
- MITSUBISHI MELSEC-FX5U(Ethernet)
» The usable Device Address number ranges of the following IDEC Drivers are extended.
- OpenNet,MICROSmart,SmartAXIS Pro/Lite(RS232C/485)
- OpenNet,MICROSmart,SmartAXIS Pro/Lite(Ethernet)

<Application Software>
The following functions have been introduced.

» Checking for updates function of Automation Organizer has supported Microsoft .NET
Framework 4. Install of Microsoft .NET Framework 2.0 to 3.5 is not needed by this
support.

Bugs Fixed
The following problems have been fixed:

» The character of Thai and Arabic is used as Windows font, it is not displayed properly.

» In Numerical Display, if [ ] (Space) is selected as "Symbol to show when Error occurs", it
is changed to [?] (Question) after reopening the project.

» If the text which is registered in "Text Manager" contains a double quote, export function
does not work properly.

» In "User Communication" tab on "Project Setting" dialog box, if the following conditions
are satisfied, an error message is displayed even if the all settings are correct. This
happens when a data except "Constant" is configured and OK button is pressed in the
"Data Settings" dialog box.

In "Command Settings" dialog box of "User Communication" tab, there is at least one
Data which satisfies all the following conditions.

"Command Type" is "RXD"
"Type" of Data is "Device Address"
"Variable" is ON

» In "User Communication" tab on "Project Setting" dialog box, even if the following
conditions are satisfied, an error message is not displayed when OK button is pressed in
the "Command Settings" dialog box.

- In "Command Settings" dialog box of "User Communication" tab, there is at least one



Data which satisfies all the following conditions.
* "Command Type" is "RXD"
* "Type" is "Device Address"
* "Variable" is ON
"Type" of the Data next to the above Data is not "Constant"
If the project contains a "Word Button" with "Comment" and it is created by using

WindO/I-NV4 Ver.1.0.0 - 1.1.0, "Failed" may be displayed when the project is opened by
WindO/I-NV4 Ver.1.2.2 or later.

Even if "Failed" is not displayed, and "Success" is displayed, base/popup screen may not
be displayed properly.

When a base screen or popup screen is copied and pasted on "Project” window, the new
screen is not displayed if the screen contains drawing objects.

In addition, when the new screen is opened after doing the above operation, the drawing
objects which are placed in the copied screen are not displayed properly.

The following devices are not displayed when "MEWNET"("#2 T H138") is selected as
Communication Driver.

(This defect only happens in Chinese Edition.)

- ENTER, ITEEBR(EEEE)

- ENER, IMHRSEIEE)

When the project which is created by using WindO/I-NV2 Ver.4.80 is opened by WindO/I-
NV4 and saved, the project cannot be opened.

When "Text" drawing object is registered in "Picture Manager" and "Use Text Area" is ON
in the object, the project cannot be opened.

In "Text" drawing object, if "Use Text Area" is OFF and the object is registered to "Picture
Manager" as NV Metafile, the object is always displayed at the top left corner of Editing
Window when the object is assigned to the "Picture" object or Part objects such as Bit
Button.

If an E-mail address is deleted when more than one E-mail address is registered in "E-
mail Address Book", and then the project file is saved, E-mail addresses in "E-mail
Settings" dialog box are changed to other E-mail address or deleted.



WindO/I-NV4 Ver.1.3.0

<Runtime System Software>

The following functions have been introduced.

4
4
4
4

E-mail function is supported.

Improve the USB autorun function screen. This is applicable to HG2G-5T and HG1G.
Improve writing recipe values.

Improve the display processing when the MICRO/I installation direction is "Vertical
(Counter Clockwise)", "Vertical (Clockwise)" or "Horizontal (Flip)".

Improve the touch sound when the data for Keep Relays and Keep Register configured in
the Data Storage Area are transferred to the flash memory. This is applicable to HG2G-
5T and HG1G.

Bugs Fixed

The following problems have been fixed:

»

4
4
4

The items of the Alarm Log Display may not be shown.

When the calendar is configured, its setting is not immediately reflected.

The MICRO/I may be reset during Offline Mode.

The Symbol to show when Error occurs of the Numeric Input is not work correctly. This
is applicable to HG4G/3G and HG2G-5F.

The MICRO/I may be reset when placing the NV Metafile which includes "Fill" on the top
layer.

<Application Software>

The following functions have been introduced.

4
4

The properties for new feature of the Runtime System Software are added.

For Alarm List Display on Editing Window of WindO/I-NV4, drawing of dotted rectangle
which indicates the text area is improved.

Bugs Fixed

The following problems have been fixed:

»

When WindO/I-NV2 project is opened and the language of WindO/I-NV2 that creates the
project and the language of WindO/I-NV4 that opens the project are different, a part of
Device Address is removed from following textbox.

- Numerical Input - "Options" tab - "Input with Arithmetic Operation"

- Numerical Input - "Options" tab - "Display with Arithmetic Operation"

- Numerical Display - "Options" tab - "Display with Arithmetic Operation"
- "Script Editor" - "Script"

- Part objects - "Trigger Condition" tab - "Condition"



When a project file is opened and if the languages of WindO/I-NV4 that creates and
opens the project are different, for Numerical Input and Numerical Display, conversion of
device symbols in "Input with Arithmetic Operation" and "Display with Arithmetic
Operation" may fail.

Tooltips of buttons on Tag Editor is displayed in English when Japanese or Chinese
Edition of WindO/I-NV4 is launched with closing Tag Editor, and then Tag Editor is
opened.

When project file for recovery is opened, string resources on Tag Editor are not displayed
correctly.

"x" button is displayed on the top right corner of the warning message which is shown
when "Communication Driver" is not connected to MICRO/I.

For the following Communication Drivers, "IP Address" and "Port Number" on
"Communication Driver Network"tab in "Project Settings"dialog box are editable.

- Modbus TCP Server

- DM LINK Ethernet(UDP)

Shortcuts of "Object List" are not running when "Object List" is undocked.

When "Message" of Message Display is modified from "Object List", error check is not
done.

When groups of drawing objects are nested, property dialog box of the drawing object
may not be opened from "Object List".

When project is not downloaded to MICRO/I or project is not opened in WindO/I-NV4,
incorrect value is displayed in the "Target Project Information" or "Opened project
Information" in "Target Information" dialog box.

When "Picture Manager" or "Script Manager" is opened from property dialog box and two
or more pictures or scripts are selected, "Select" button is not masked.

"Undo" function for "Auto Resize" function is not running properly.

In "Picture Manager", picture name which length is 121 characters or more can be set.
In Recipe Settings, if "Access To" is "Internal Memory", "Data List" is not restored after
uploading project.

Project file may not be opened properly if the file extension contains capital letters.
When project file is saved, if project file name input by user contains file extension and
the file extension contains capital letter, extra file extension is appended.

After "Rotate Right 90°", "Rotate Left 90°", "Flip Vertical", or "Flip Horizontal" is clicked,
"X-coordinate", "Y-coordinate", "Width", and "Height" on "Format" tab of Ribbon are not
updated.

If Polyline or Polygon is arranged, "X-coordinate" or "Y-coordinate" on "Format" tab of
Ribbon is modified, and then "Width" or "Height" is modified, incorrect image is
displayed.

Accelerator key of "< Basic" button and "Advanced >" button on property dialog box of
part objects is not running properly.

In property dialog box of Word Button, unnecessary control is displayed when "Data
Type" is other than "Float32(F)" and "Action Mode" is Arithmetic operation or Logical
operation.

For Selector Switch, if "Font" of each channel is different, "Text" of Channel 2 and 3 are
drawn on Screen Window with "Font" of Channel 1.

WindO/I-NV4 may freeze when "Picture Manager" is opened from property dialog box of
Picture Display, and a picture that is used in the Picture Display is overwritten by other



picture which file name is same as the picture.

In property dialog box of Message Switching Display, strings updated on "Text Manager
dialog box may not be applied properly.

In Alarm List Display, correct text may not be displayed on Editing Window.

The number of lines which is shown on Message Display may be difference between
WindO/I-NV4 and MICRO/I.

In property dialog box of Message Switching Display, "Change" column of "Settings" list
becomes blank when "Use Text Manager" check box is ON.

In property dialog box of Alarm Log Display, if "Height(dots)" is 161 or more, it is not
restored correctly after saving and opening project.

In the property dialog box of Message Switching Display, the cursor on the character
string in "Message" column of "Message" tab cannot be moved.



WindO/I-NV4 Ver.1.2.3

<Application Software>

Bugs Fixed
The following problems have been fixed:

» In text boxes of the following dialog boxes, line feed cannot be inserted even if the Enter
key is pressed.

- Selector Switch - "Notch Settings" dialog box
- Multi-State Lamp - "State Settings" dialog box

» In Multi-Button, when "Word Write" is selected as the first function in "Function List" and
"Action Mode" is either Arithmetic, Modulo, or Bit Operation, even if "Device Address" is
selected as "Source2" on "General" tab, the setting is changed to "Value" after reopening
the project.

» In Numerical Display, when other than "BIN16(W)" is selected as "Data Type", and an
expression including value which is not an integer number from 0 to 65535 is entered in
"Display with Arithmetic Operation" in "Options" tab, error message appears when the
project is downloaded and the project cannot be downloaded.

» In Numerical Display, it has the following problems.

- When [*] (asterisk) is selected as "Symbol to show when Error occurs", it is changed
to [!] (exclamation mark) after closing with "OK" button and then reopening the
property dialog box.

- When [!] (exclamation mark) is selected as "Symbol to show when Error occurs", it is
changed to [+] (plus) after closing with "OK" button and then reopening the property
dialog box.

- When [+] (plus) is selected as "Symbol to show when Error occurs”, the property
dialog box cannot be opened again after closing with "OK" button.

» When a project which stores pictures in External Memory is uploaded and the External
Memory is ejected at that time, following problems occur in the uploaded project.

- When project file for External Memory (ZNV file) is created, error message appears
and creating ZNV file fails.

- When the setting of the picture which is stored to External Memory is changed to
store to Internal Memory, and the project is downloaded, the drawing of picture on
MICRO/I is incorrect.

- When the picture is used in Picture Display, the picture name is changed.

» In the property dialog box of Part Objects and Settings, when the Device Address which
satisfies the following condition is assigned to the Text Box, even if "..." button is
pressed, Tag Editor does not appear.

"Device Type" is a device type which has more than one range of "Device Ranges"
"Address Number" is greater than the range of the first item of "Device Range"



WindO/I-NV4 Ver.1.2.2

<Runtime System Software>

The following functions have been introduced.

» The judgment of device range error is improved. This is applicable to HG4G/3G and

HG2G-5F and HG1G.

» The size of Password Screen is enlarged. This is applicable HG1G.

Bugs Fixed

The following problems have been fixed:

»

In Picture Display, if used "Dynamic Position" or "Dynamic Size", the picture before
moving or scaling remains.

<Application Software>

Bugs Fixed

The following problems have been fixed:

4

MICRO/I may not work properly if comment is set in Word Button or Multi-Button (the
first function is Word Write or Script) and the button is pressed on MICRO/I after the
project is downloaded.

If Data Displays or Charts is arranged and project is downloaded, the plate part of the
object may not be drawn properly on MICRO/I.

In "Custom Monitor", "Batch Monitor", and "Screen Monitor", if used Device Address is
Hexadecimal, MICRO/I access to incorrect Device Address.

In "Communication Driver Network" tab on "Project Settings" dialog box, if the following
Communication Drivers are assigned to more than one External Device ID and "OK"
button is clicked, an error message appears, but the "Project Settings" dialog box closes.

- DM LINK(1:1)

- DM LINK(1:N)

- DM LINK Ethernet(UDP)
- Modbus RTU Slave

- Modbus TCP Server

The settings are not change back to the default when the property dialog box of the
following part objects is changed to Basic mode from Advanced mode by using
"Basic/Advance" button.

- Numerical Input

- Line Chart

- Alarm List Display
- Alarm Log Display



- Video Display

When WindO/I-NV2 project is opened in WindO/I-NV4, even if the project name is less
than or equal to 50 bytes, an error message is displayed and the project cannot be
opened.

If Allen-Bradley Logix Native Tag is selected as Communication Driver, the tags which are
assigned to part objects or settings may be deleted.

When the base screens and popup screens which are modified are closed in WindO/I-
NV4 window, the confirmation message for saving the project may not be displayed.
When "AutoRecover file" function or "Backup" function is enabled, the modification in
base screens and popup screens may not be applied to the MICRO/I after downloading
the project.

If WindO/I-NV2 project is opened by WindO/I-NV4 Ver.1.0.0 to Ver.1.0.4, and then the
project is opened by WindO/I-NV4 Ver.1.2.0, "Failed" may be displayed at "Status"
column in "Convert the project data" dialog box.

If "Channel Number" is changed on "General" tab in "Individual Settings" dialog box
which is opened from "Data Log Settings" dialog box, the saved project may not be
opened.

After a project is downloaded with "Modified Data Only" option in "Download" dialog box,
if the project is uploaded from MICRO/I, "Number of Text Group" in "Text Manager"
dialog box may be changed to incorrect value.

"Sort" on "General" tab in the property of Alarm List Display cannot be changed from
"Ascending".

When WindO/I-NV2 project is opened in WindO/I-NV4, the picture image in the project
may be changed incorrectly.

In Multi-Button, there are the following problems.

- When other than "Bit Write" is selected as the first function in "Function List", even if
"No Touch Sound" on "Options" tab is ON, the setting is changed to OFF after
reopening the project.

- When "Print" is selected as the first function in "Function List", even if "Alternate" is
selected as "Action Mode" on "General" tab, the setting is changed to "Momentary"
after reopening the project.

- When "Script" is selected as the first function in "Function List", even if
"Basic/Advanced" mode is "Advanced", the setting is changed to "Basic" after
reopening the project.

In Alarm List Display, when "Screen No." on "Option" tab is greater than or equal to 256,

incorrect Screen No. is set.

When picture is imported in Picture Manager, color of the picture may be converted to an
unexpected color.



WindO/I-NV4 Ver.1.2.1

<Runtime System Software>
The following functions have been introduced.

» The judgment of device range error is improved. This is applicable to HG2G-5T.

<Application Software>

Bugs Fixed
The following problems have been fixed:

» In Preview function, if Buttons, Lamps, or Data Displays are displayed, unnecessary
dotted rectangle may be displayed.



WindO/I-NV4 Ver.1.2.0

<Runtime System Software>
The following functions have been introduced.

» HG1G is supported.
» "Horizontal (Flip)" of "Installation direction" is supported. This is applicable to HG2G-5T
and HG1G.

» FTP Server function is supported.

Bugs Fixed
The following problems have been fixed:

» If "Number of Stored Data for Data Log per Device Address" is odd number, MICRO/I
may be reset when the Operation Log function works.

» When the screen which uses "Overlay with Base Screen" is displayed, the values of
"Coordinates" of "Overlay with Base Screen" are added to the coordinates of the objects
on the popup screen.

» If you enter the numbers, the numbers may be drawn out of the frame when "Update
the display by ENT button" of the Numeric Input is OFF,

» The scaled image file is different from the HG2G-55/-S.

» The transparent areas of Multi-State Lamp and Picture Display are painted with the
screen background color.

<Application Software>
The following functions have been introduced.

» Windows 10 is supported.
» The properties for new feature of the Runtime System Software are added.

» Standard popup screens for HG2G-5T are updated to make them usable when vertical
installation.

Bugs Fixed
The following problems have been fixed:

» In the property of Calendar, even if "Jan/Feb/Mar/..." is selected as "Month" in "General"
tab, "7-Segment" can be selected as "Font" in "Format" tab.

» In Preview function, ON/OFF state of Buttons and Lamp is not displayed according to the
display image of Editing Window.

» When a project is opened, "Slavel" is selected as "Slave Station" of O/I Link Slave.

» In Script Editor, when the following functions are described and an assignment
expression is used for an External Device Address, it causes script error.
- ASCII2DEC

- STRLEN



- STRSTR
In "User Communication" tab of "Project Settings" dialog box, when "Trigger Condition"
contains a fixed value, the project may not be able to be downloaded.

In "User Communication" tab of "Project Settings" dialog box, even if an invalid Device
Address is used in "Trigger Condition", the project can be downloaded.

When Reuse Screens is used for the different Type Number of the current project, the

following problems happen.

- The part object which uses "Standard" Image Type becomes transparent

- The property dialog box of the part object which uses "Standard" Image Type cannot
be opened

- A new Part object cannot be placed

When Print Command or Multi-Command is placed on base screen or popup screen and
the project is opened and saved without opening those screens, the Print Command and
Multi-Command may be moved to the left top side(coordinate X:0, Y:0).

When Product Series is changed on "Change Product Series" dialog box, the following
settings in "Project Settings" dialog box are changed to the default.

- "System" tab - "Use System Area 3,4"
"System" tab - "Enable Maintenance"
- "Communication Interface" tab - "Interface Settings" - "Port No."

In "Recipe Settings" dialog box, when "External Memory Device" is selected as "Access

to" in "Block" tab and "Hexadecimal" is selected as "Display Type" in "Channel" tab, CSV

file is not created properly by the following operation.

- Save the recipe files to the External Memory by using "Save Recipe Files to External
Memory Device..." button in "Recipe Settings" dialog box

- Download the project to the MICRO/I



WindO/I-NV4 Ver.1.1.0

<Runtime System Software>

The following functions have been introduced.

4
4
4

HG4G/3G and HG2G-5F are supported.
O/I link communication protocol of HG4F/3F/2F/2S/1F is supported.

In the Web Server function, when you do not click anywhere in the remote control page
or the remote monitoring page in a certain period of time, the current page is
automatically switched to the home page if you enable this function.

In Security function, the password entry screen is displayed automatically when
operating the parts.

In Security function, the setting to notification when an unauthorized user has operated
is added.

In PLC program transfer function, SmartAXIS Pro/Lite is supported.

Allen-Bradley Logix Native Tag (Ethernet) Driver is supported.

The usable Device Address number ranges of the following IDEC Drivers are extended.
- OpenNet,MICROSmart,SmartAXIS Pro/Lite(RS232C/485)

- OpenNet,MICROSmart,SmartAXIS Pro/Lite(Ethernet)

The message which is displayed when a device range error occurs is modified.

The error information string is added in the message which is displayed when a device
range error occurs.

XXXXX_YYYYYyyyy_2227227777
X: MICRO/I system software version, Y: Category, y: Details, Z: Reserved

Category and Details are followings.

B, S Base/Popup screen number (y is the screen and the internal object number of the error's
occur)

G Global Script(y is script ID)

X User Communication (y is "0000")

P Preventive Maintenance Function (y is "0000")

L Data Log or Line Chart (y is "0000")

R Alarm Log or Recipe (y is "0000")

@) Operation Log (y is "0000")




Y

System Area (y is "0000")

Example:43500_B0001_005_01076840E(MICRO/I Version 4.35.00, the base screen number
is 1 and the internal object number is 5)

4

4

When "Show script error" in the Project Setting is ON, MICRO/I displays Device range
error.

After downloading or uploading the project data by using USB Autorun function or the
Key Button, the SD card and USB memory stick are unmounted. You can pull out the SD
card or USB memory stick when confirmation screen is displayed. They are mounted
again automatically when MICRO/I restarts.

<Application Software>

The following functions have been introduced.

4
4

The properties for new feature of the Runtime System Software are added.

If the project contains a lot of part objects and "Satisfy the condition" or "While satisfying
the condition" is selected as "Trigger Condition" of those part objects, the performance
for opening the project is improved.

The Behavior of "»" button which displays the check boxes on "Screen Monitor", "Custom
Monitor", and "Batch Monitor" dialog box is improved.

Check state of radio button is now kept if checked radio button is selected and the Tab
key is pressed.

The following lists are updated faster when changing the number of columns.

- Alarm Log Settings

- Recipe Settings

- "Number of State" of Multi-state Lamp

- "Number of Registering Constants" of "Data Settings" in User Communication Setting
- "Number of Items" of Preventive Maintenance

When an item is clicked in "Info Window", the related part object is selected.

In "Preventive Maintenance Settings" dialog box, if numerical value is entered into
"Number of Items" directly, the list of "Settings" is now updated immediately.

Bugs Fixed

The following problems have been fixed:

4

When "Obiject List" is displayed, if "Undo" or "Redo" is executed for more than one
drawing object and part object, WindO/I-NV4 stop operation for a few seconds.

Title bar of "Object List" blinks when "Up" or "Down" button on "Object List" is clicked.
When both drawing objects and part objects are placed on the same screen, if "Object
List" is separated from Workspace and its window size is changed, the scroll bar of the
"Object List" is not displayed properly. In addition, the line which separate drawing
objects and part objects is not displayed proper position.

In "Global Script" dialog box, "..." button displayed in "Trigger Condition" tab is always
enabled.




Other than text can be pasted into "Script" in "Script Editor".

In Script, when "if" statement exists in "default" of "switch" statement, the script does
not work properly.

In Script, when more than two "return" statements exist, the second or later "return"
statements don't work.

In "Script Editor" dialog box, Script Error is not displayed even if "@" is described as
Device Address.

In Script, the Device Address of Emerson ROC Protocol can be set as argument of the
following functions.

- STRCUT()

- STRLEN()

- STRCAT()

- STRSTR()

- DEC2ASCII()

- ASCII2DEC()

When the part object which contains script setting is grouped, it is not displayed in "Info
Window".

If Tag Editor is launched from "..." button in property dialog box, and Refresh button is
pressed, the cells which contain Tag Name cannot be modified in the Tag Editor in
Workspace.

If Tag Editor is launched from "..." button in property dialog box, and Refresh button is
pressed, the Tag Name cannot be changed after entering comment.

In Tag Editor, if "Delete Key is pressed when Tag Name and comment are selected, only
comment is deleted and Tag Name will not be able to be deleted after the operation.

If Emerson ROC Protocol is selected as Communication Driver, the color of the following
controls is incorrect when they are selected.

- Location

- Bit

If "Allen-Bradley" format is selected as "Expression of Device Address Format", the
Device Address which is configured in Trigger Condition is not restored properly after
reopening the project.

Comments of LSM(HMI Special Relay) and LSD(HMI Special Register) which are imported
when creating a new project cannot be deleted.

Right after clicking "OK" button on "Data Storage Area Management" dialog box,
keyboard shortcuts for part objects on screen don't work.

In "Data Log Settings" dialog box, even if "Up" or "Down" button is pressed, the column
of "Number of Data" in the list of "Settings" is not displayed properly.

If Symbol Factory is opened from "Picture Manager" and clipboard is updated from other
program, Symbol Factory is closed.

Size of NV Metafile on "Picture Manager" is not displayed.

After pictures are imported in "Picture Manager", the folder which contains the imported
pictures cannot be deleted.

When drawing objects are registered to "Picture Manager", the background color may be
black.

If a picture is assigned to a Picture Display and "Undo" is executed, the picture cannot be



deleted from "Picture Manager".

If the picture in "Picture Manager" is used in Picture of drawing object or Part objects,
the display image of the picture in Editing Window is smaller than the actual size.

In "Communication Driver Network" tab on "Project Settings" dialog box, the setting of
"External Device Communication" is not reflected if the setting of "External Device
Communication" is changed and then the tab is changed.

In "Communication Driver Network" tab on "Project Settings" dialog box, the same "Slave
Number" can be selected for more than one External Device ID which is configured the
same "External Device Communication".

In "Communication Driver Network" tab in "Project Settings" dialog box, even if
"Disabled" is selected as "External Device Communication"”, "External Device Name" is
checked as valid name, and error message is displayed.

In "Communication Driver" tab in "Project Settings" dialog box, the invalid error message
"Device Address is empty" is displayed when "Ignore communication errors and continue
operation" check box is ON and "Not use" is selected as "Manufacture”, then "OK" button
is pressed to close the dialog box.

In the following Communication Drivers, "MCIRO/I Port No." of "Expansion Settings" on
"Communication Driver Network" tab in "Project Settings" is not reflected to the behavior
of the MICRO/I.

- YASKAWA Electric MP2000(Ethernet)

- OMRON SYSMAC CS1/CJ series(Ethernet)

When creating a new project if the following Communication Driver is selected, the

default value of "Expansion Settings" on "Communication Driver Network" tab in "Project

Settings" is not set.

Modbus TCP Client

- OMRON SYSMAC CS1/CJ series(Ethernet)

YASKAWA Electric MP2000(Ethernet)

Emerson ROC Protocol

When the following conditions are satisfied, the project cannot be reopened if "Project

Settings" dialog box is closed by "OK" button.

- Emerson ROC Protocol is selected as Communication Driver

- TLP Device Address format is used

The Device Address of "Change IP Address and Port Number by Device Address" on

"Communication Interface" tab in "Project Settings" is not replaced by Replace function.

After reopening the project, "Baud Rate" is displayed as blank when "O/I Link Master" or

"O/I Link Slave" is selected as "Function" on "Communication Interface" tab in "Project

Settings" dialog box.

In "Individual Settings" dialog box of "Preventive Maintenance", when "Measure

Operation Count" check box in "Operation Count" is OFF, "..." button of "Monitor Device

Address" is masked.

In "Preventive Maintenance Settings" dialog box, even if "Up" or "Down" button is

pressed, the following columns in the list of "Settings" are not displayed properly.
"Operation Count" - "Level2 Threshold" and "Level2 Report Device Address"
"Operation Count" - "Level3 Threshold" and "Level3 Report Device Address"

In "External Memory Device" tab of "Alarm Log Settings" dialog box, error message is
displayed even if correct Device Address is set to "Specify File Name by Value of Device



Address".

Invalid Device Addresses are displayed on "Source" column of "Settings" when the Device
Address of Emerson ROC Protocol is assigned on "Channel" tab in "Alarm Log Settings"
dialog box.

Scroll bar of Screen Monitor may be moved to cursor position forcibly.

If a project file is dragged and dropped during monitoring, the current opening project is
forcibly closed.

Device addresses may not be replaced when replace function is executed while
monitoring.

"External Devices" icon in "Online" tab is active even if "External Device Communication 1
to 4" is not configured in the current project.

If the project name consists of 50 byte characters, Monitor, Download and Upload cannot
be used. In addition, the project name is displayed as blank in "Target Information"
dialog box.

When the following conditions are satisfied, the files which are stored in External Memory
of the MICRO/I cannot be uploaded.

- After launching WindO/I-NV4, Online functions such as Download and etc. have not
been used

- Project is not opened

When uploading the project from MICRO/I, if a picture file is exist in External Memory
and the picture file is not registered in the "Picture Manager" of the uploaded project, the
project cannot be downloaded.

Even if a part of Picture or Text of drawing object or Part object is placed on the outside
of the screen area, error message does not appear when the screen is not opened.

In the following functions, if a column in the list in "Open Screens" dialog box is double
clicked, the selected screen is opened.

- Reuse Screen
- Replace

In the following dialog box, a part of the cells disappear when the mouse cursor is
moved on the cells.

"Screen Properties"
"Properties of Multi-Button"
"Properties of Multi-Command"
Symbols of multi byte character can be set in the following settings.
"Security" - "User Name"
- "Security" - "Use Password to open Project"
"Properties of Key Button" - "Location"

Mouse cursor image is not displayed properly after clicking "?" icon which is located at
the left top side of dialog box.

Screen Diagram is not updated correctly when screens are deleted or "Number" of
screens is modified.

Invalid Device Address can be set by using "Replace" function.

If the following alignment is configured, and "Stroke" is selected as "Font", the text is not
displayed proper position.

- Align Text Horizontal: Center-Left, Left-Right



- Align Text Vertical: Center-Top

In Text of drawing object, if the following conditions are satisfied, the text is not
displayed proper position when "Text Group" on Status bar is changed.

"Use Text Area" check box is OFF
"Use Text Manager" check box is ON

If the WindO/I-NV2 project contains the Multi-Command which has the following Word
Write Command, the property dialog box is displayed as "Basic" mode instead of
"Advanced" mode when the project is opened by WindO/I-NV4.

- "Action Mode" : "Move"
"Data Type" : "BIN32(+)"

If a text ID of "Text Manager" is assigned to registration text of Buttons and "Bold" is
selected as "Style", the selected item of "Style" is changed to "Regular" from "Bold" after
reopening the project.

(This defect only happens in Japanese and Chinese Edition.)

In Bit Button, if "Reset" or "Toggle" is selected as "Action Mode" and this Bit Button is
converted to Word button by using "Change Part Type" in Context Menu, the property
dialog box cannot be opened.

In Key Button, warning message is not displayed when a key is selected in "Key Browser"
even if Registration Text is already entered.

In the property dialog box of Numerical Input and Character Input, unnecessary
verification is executed and error message is displayed.

If a popup screen is created from the property dialog box of Numerical Input or
Character Input, and then the following part object is placed on it, the popup screen is
not displayed properly.

- Selector Switch

Potentiometer

Keypad

- Alarm List Display

Alarm Log Display

In Numerical Input, if the following items are selected as "Methods of using the
Numerical Input", a different item is selected when reopening the project.

- Display the Minimum value specified with Data Over
- Display the Maximum value specified with Data Over

When the following part object is placed and the object size is indicated, the flange area
and button area may be overlapped.

- Selector Switch
- Potentiometer

In Calendar, if the following conditions are satisfied, error message appears when
downloading the project.

"Alarm" or "Clock & Alarm" is selected as "Calendar Type"
"Device Address" is selected in "Alarm" tab

If Windows font is selected as Registration Text of Multi-state Lamp, the screen which
contains the Multi-state Lamp cannot be opened after reopening the project.

In the property dialog box of Multi-state Lamp, if numerical value is entered into



"Number of State" in "State" tab, and it decrease the number of state, incorrect number
of columns are displayed in the list of "Settings".

When "OK" button is pressed in the property dialog box of Multi-state Lamp, the image
and registration text of state 0 is displayed.

In Message Switching Display and Multi-state Lamp, if the following alignment is
configured, the coordinate of the text becomes incorrect in Editing Window and the
MICRO/I.

- Align Text Horizontal: Center-Left, Left-Right

- Align Text Vertical: Center-Top

In Alarm List Display, the registration text of the buttons are not displayed in proper
position in "View" tab.

In the property dialog box of Alarm List Display and Alarm Log Display, if "Browse"
button in "View" tab is pressed, and a Fixed Flange object is selected in "View Browser",
the width of flange in Editing Window is wider than proper width.

In Alarm List Display and Alarm Log Display, the setting of "Style" in "Format" tab is
reflected to the registration text of the buttons in "View" tab and "View Browser".

In the property dialog box of Alarm Log Display, even if a text which is registered in "Text
Manager" is assigned to the "Title" in "Log" tab, the setting of "Style" in "Format" tab is
not reflected to the title text of Alarm Log Display in Editing Window.

In the property dialog box of Alarm Log Display, the height of background of messages in
Editing Window is different from the display image on MICRO/I when "Reverse" check
box in "Format" tab is ON.

In "Format" tab on the property dialog box of Alarm List Display and Alarm Log Display, if
other than 1 is selected as "Magnification H", and then the same part object is created
on the screen, the message area of the new object is not displayed properly.

In "Format" tab on the property dialog box of Alarm Log Display, if other than 1 is

selected as "Magnification H", the following problems occur.

- In Editing Window, messages on Alarm Log Display are not displayed properly

- In Editing Window, the coordinate of messages and Lines on Alarm Log Display is not
the same as the MICRO/I

Even if base screens and popup screens are reopened, "Undo" and "Redo" work.

If following items are changed from context menu, the result is not displayed correctly,
and "Undo" does not work.

- "Line Width"

- "Line Type"

- "Color" - "Foreground Color", "Background Color", "Text Color", "Text Background
Color", "Shadow Color"

- "Size" - "Make Same Width", "Make Same Height"

In Editing Window, when more than one drawing object and part object is moved, the

rectangles which indicate the objects are not displayed properly.

In Line of drawing object, if the coordinate of X or Y is configured from "Format" tab in
Ribbon and the value is greater than the Editing Window, the configuration is not
applied.

Drawing objects and part objects which are bigger than the base screen size cannot be
resized in Editing Window.

The context menu which is displayed when drawing objects or part objects are not



selected appears when the dot line which indicates the popup screen in the base screen
is selected and left mouse button is clicked.

A part of the rectangle is not displayed properly while the Rectangle of drawing object is
resizing in Editing Window.
If the following drawing objects are located outside of Editing Window, scroll bar is not
displayed.

"Point 1" of Line
- Fill
If Line and other drawing objects are selected and moved to the side of Editing Window,
the positional relationship between those drawing objects is changed.

If more than one drawing object and part object is selected and "Send to Back" is
executed, the order of the selected objects is reversed.

If Reshape mode of Poly Line or Polygon is terminated by "ESC" key, and then "Line" on
"Home" tab is clicked, unexpected line is drawn from the End Point of PolyLine or Polygon
to the top left corner of Editing Window.

The following items are not displayed properly when the part object is placed outside of
the base screen or popup screen.

Part Name

Device Address

- Trigger Condition

Security Group

Grid setting is not applied when moving or resizing the dot line of the popup screen.

If Reshape mode of Poly Line or Polygon is terminated by "ESC" key, and then Poly Line
or Polygon is selected in Toolbox and the drawing object is drawn, unexpected line is
drawn from the top left corner of Editing Window to the Start Point of the drawing
object.

The Rectangle of drawing object which contains the following settings is not displayed in
Editing Window.

"Curve" is selected as "Round Type"

"1" is entered as "Round Radios"

"Convex" or "Concave" is selected as "Shadow"
"Display" and "Input" check box on "View" tab in Ribbon may become active even if
screens are not opened.
If Line of drawing object and other drawing object or Part object is selected and "Align"
is executed, the function may not work properly.
In Editing Window, even if "Snap to Grid" is enabled, a drawing object may not be
snapped to the grid when it is resized.
If the WindO/I-NV2 project name is changed without WindO/I-NV2, and then the project
is opened by WindO/I-NV4, the settings on "Communication Driver Network" tab in
"Project Settings" dialog box is deleted.
The picture which satisfies the following conditions is not displayed as X sign after
downloading the project to the MICRO/I if the project is originally created by WindO/I-
NV2 and opened by WindO/I-NV4.
- NV Metafile

- The picture is stored into External Memory



If the WindO/I-NV2 project contains Text of drawing object and "Use Text Area" is OFF,

the size of Text is increased by 1 dot after the project is opened by WindO/I-NV4.

If the WindO/I-NV2 project contains Multi-state Lamp and it satisfies the following

conditions, linefeeds are removed when the project is opened by WindO/I-NV4.
"Windows" is selected as "Font" in "Registration Text" tab

- Registration Text contains linefeeds

If "Active User" is registered in Quick Access Tool Bar and "OK" button is pressed in

"Open Screens" dialog box when opening a project, the following message appears.

"WindO/I-NV4 cannot read this file.

This is not a valid file, or its format is not a project file."

When "Arrange" or "Size" is added to Quick Access Tool Bar and "Coordinates" or "Size"

of Drawing objects or Part objects is changed by those "Arrange" or "Size", the display

image on Editing Window is not changed.

When "Arrange" is added to Quick Access Tool Bar and set the focus to "X" or "Y" of the

"Arrange", "Align" and "Rotate" cannot be used from the "Arrange".

If the text box of "State" in "View" tab is added to Quick Access Tool Bar, and then Multi-

state Lamp, Message Switching Display or Picture Display is placed on Editing Window,

WindO/I-NV4 crash.

If the text box for changing screen in "Online" tab is added to Quick Access Tool Bar, and

enter invalid character while monitoring, WindO/I-NV4 crash.

Label text in Ribbon can be added to Quick Access Tool Bar.

The icon which is registered on Quick Access Tool Bar is not masked when project is not

opened.

Even if Text Group is changed, "Text Group" in Quick Access Tool Bar is not updated.

When "Emerson RCO Protocol" is selected as Communication Driver and a Device

Address of TLP device format is selected as "Source" on "General" tab in "Individual

Settings" dialog box of "Data Log Settings" dialog box, the project cannot be opened.

When reopening the project, "O/I Link Station" on "O/I Link" tab in "Project Settings" is

change back to the default.



WindO/I-NV4 Ver.1.0.4

<Runtime System Software>

Bugs Fixed

The following problems have been fixed:

4

If more than one Communication Driver is configured, MICRO/I may be reset when an
indirect read is executed to a non-existent Device Address in the external device.

In Line Chart, when the date and time data at the position indicated by the cursor is
displayed with 7-Segment font, it is not displayed correctly.

<Application Software>

The following functions have been introduced.

4

Color Palette or Pattern Palette is displayed when other area than the down triangle
symbol on color selection button or pattern selection button is clicked.

When "Picture Manager" dialog box or "Script Manager" dialog box is opened from
property dialog box, the selected item in the property dialog box is selected as default.
After a picture is imported in "Picture Manager" dialog box, the format of the picture file
is properly converted according to the original format and the state of "Color Exchange"
check box.

Bugs Fixed

The following problems have been fixed:

»

The following problems happen when decimal symbol in "Region and Language" is not
period. ("Region and Language" is configuration of Windows OS)
- Fixed value cannot be set in "Trigger Condition" when "Data Type" is "Float32(F)".

- Property dialog box of Part object cannot be opened when "Data Type" is "Float32(F)"
(This problem only happens when setting of "Value" exists).

In addition to above, the following problems happen when digit grouping symbol is
"space".

- Project cannot be downloaded.

- WindO/I-NV2 project cannot be opened.

If Windows font is used, the image is lacked.

For Line Chart, if Windows font is used for label which is displayed on Y-Axis, the label is
displayed on incorrect position in Editing Window.

When opening project, setting of "Back to Default User" in "Security" dialog box is not
restored correctly.

In "Project Settings" dialog box, if "User Communication" or "Sub Host Communication"
is selected as "Function" of "SERIAL1(RS422/485)" in "Communication Interface" tab,



"Serial Interface" may be changed to "RS422/485 2-wire".

Change Product Series does not work when project name contains period.

While changing product series, if "Cancel" button is clicked on "Save As" dialog box,
changing product series is canceled, but "Installation" is changed.

Project may not be uploaded if picture exists in "Picture Manager" of the project.

If base screens or popup screens are reused with "Reuse Screen" from project whose
"Installation" is different, size of reused screens becomes invalid.

For Line Chart, if "Chart Type" is "Device Address Display" and "Reference Device
Address" is Device Address of External Device, the Line Chart does not work on MICRO/I
correctly.

If WindO/I-NV2 project contains Message Display and its "Change Color by Device" is
enabled, this Message Display does not work after the project is opened and then
downloaded with WindO/I-NV4.

If picture files are imported in WindO/I-NV2 project with "Import with color conversion”
enabled, these picture files may be displayed incorrectly after the project is opened with
WindO/I-NV4.

Image of imported picture file in "Picture Manager" may become incorrect when format
of the picture file is following.

- ICOfile

- WMF file

When WMF file is imported in "Picture Manager", the size of the imported picture file is

not proper.

Even if duplicated "Text ID" is found when "Copy", "Cut", "Paste", or "Reuse Screen" is

used, confirmation message for overwriting "Text ID" is not displayed.

Even if "Text Align" in "Format" tab is changed in property dialog box, the modification

may not be reflected when multiple Numerical Inputs or Numerical Displays are selected.

Even if "With Unit" in "Format" tab is changed in property dialog box, the modification

may not be reflected in Editing Window when multiple Numerical Inputs or Numerical

Displays are selected.

For Numerical Input and Numerical Display, if numerical value is set as unit, its preview is

not correctly displayed in Editing Window.

WindO/I-NV2 project cannot be opened when NV Metafile which contains Circle/Ellipse or

Arc is imported in "Picture Manager".

For Numerical Input, Character Input, Message Display, Message Switching Display,

Numerical Display, and Calendar, property dialog box cannot be closed with "OK" button

if all following conditions are satisfied.

- "Image Type" is "None".

- The last item in "Object List" is a button.

If O/I Link Slave is configured in "Project Settings" dialog box, error message is displayed

and the dialog box cannot be closed.

If Multi-Button is arranged, following problems may happen.

- If "Bit Write" is set as second or later item in "Function List", and "Destination Device
Address" is a Device Address of External Device, the Bit Write does not work
correctly.

- If "Word Write" is set as second or later item in "Function List", "Transfer" and "Write"
become default after reopening project.



If "Reuse Screen" is used, the following problems may happen.

- Device Addresses and "Trigger Condition" in the duplicated screens are deleted.
- "NG" is displayed on "Error" column in "Script Manager"

If "Not Display Image" is ON in Pilot Lamp, following problems happen.

- If the screen which contains this Pilot Lamp is reused with "Reuse Screen", the
screens may not be displayed correctly.

- This Pilot Lamp cannot be pasted to another WindO/I-NV4 screen.

When multiple screens are reused with "Reuse Screen”, following problems happen if the
same picture is used in more than one screen.

- the reused screens may not be displayed
- the picture in the reused screens is not correct

When multiple screens are reused with "Reuse Screen", setting of Script Manager may
become incorrect if the same script ID is used in more than one screen.

Security setting may become incorrect if downloading or uploading is aborted.
Project may not be saved correctly if Bit Number of LKR (HMI Keep Register) is used.

For Message Switching Display and Keypad, if all following conditions are satisfied, the
screen which contains the part object is deleted.

"Stroke" is selected as "Font"
- Message is set in "Message" tab (For Message Switching Display only)



WindO/I-NV4 Ver.1.0.3

<Runtime System Software>
Bugs Fixed
The following problems have been fixed:

» When the screen display is updated, MICRO/I may be reset.



WindO/I-NV4 Ver.1.0.2

<Runtime System Software>

Bugs Fixed

The following problems have been fixed:

4

When Modbus TCP Server Driver is set to other than "External Device Communication 1",
MICRO/I cannot communicate to the external devices.

<Application Software>

The following functions have been introduced.

4
4

Auto Backup function is supported.

In "Project Settings" dialog box, if "External Device Communication" is used in
"Communication Interface" tab or "Communication Driver Network" tab, and
Communication Driver is not assigned to the "External Device Communication", Error
Message appears.

Bugs Fixed

The following problems have been fixed:

»

After reopening the project, when "Recipe Setting" dialog box is not opened and project
is downloaded, MICRO/I reads and writes to incorrect recipe files.

Project may not be saved.

When property dialog box of Line Chart is closed, the following message may appear
even if there is no invalid setting.

"The sampling method of the "Channel Number" has different settings.
It may not be displayed correctly. Do you want to continue?"

When reuse screens, the following problems which are related to HMI Keep Relay(LK)
and HMI Keep Register(LKR) happen.

- The property which uses those Device Addresses is changed to blank.

- If those Device Addresses are used in script, the Device Addresses are not deleted
even if the address is greater than the maximum address.

When changing Communication Driver, the property which uses the following Device

Address is changed to blank.

- The Device Address can be read and written by MICRO/I in the Communication Driver
which is configured before changing

- The Device Address can be read, but cannot be written by MICRO/I in the
Communication Driver which is configured after changing

When changing Communication Driver, a part of scripts is removed.

If the security group which is assigned to a part object does not exist and "Undo" or
"Redo" is executed, security setting becomes invalid and the following problem may



happen.

- The property dialog box of part object cannot be closed

- WindO/I-NV4 may freeze if you edit Security Group setting

If you operate the following steps, the event names are not described in Operation log
file in External Memory.

1. Create a new project

2. Disable Operation Log function and save the project

3. Reopen the project and enable Operation Log function

4. Download the project to the MICRO/I

The downloaded recipe file name in External Memory is not proper. The default file name
is used instead of the setting file name on "Block" tab in "Recipe Setting" dialog box.

In Protocol 2 through 7, if "User Communication" is selected as "Function", the same
Device Address of Protocol 1 is displayed in "Change IP Address and Port Number by
Device Address".

If "Windows" is selected as "Font" for Text ID1 of Text Group1l in Text Manager, and "Bold
Italic" is selected as "Style" of the Windows font, the "Style" setting is changed to
"Regular" after reopening Text Manager.

In Message Switching Display, "Text Color" and "Plate Color" on "Message" tab are not

reflected to the display image on Editing Window.

(This defect only happens in Japanese and Chinese Edition.)

Project cannot be saved when the following conditions are satisfied.

- The opened screen contains grouped objects or drawings

- The state of "Handle Logical operations as Bit operations" on "Compatible" tab in
"Project Settings" dialog box is changed.

In Message Switching Display, If "Value" is selected as "Switching Method" in "General"

tab, the following defects are caused.

- If the value of "State" on "Screen" group in "View" tab of Ribbon is greater than 15
and "Switching Method" is changed to "Bit Number", the property dialog box of the
Message Switching Display cannot be closed.

- Even if the order of the message is changed in "Message" tab, it is not reflected to
the display image of the Message Switching Display on Editing Window.

when the value of "State" on "Screen" group in "View" tab of Ribbon is not zero, the

following objects cannot be displayed as proper state.

- Duplicated Message Switching Display, Multistate Lamp and Picture Display

- Pasted Message Switching Display

If you copy an object and paste it to another WindO/I-NV4, the Device Address of HMI

Keep Relay(LK) and HMI Keep Register(LKR) which is greater than the settings in "Data
Storage Area Management" dialog box can be assigned.

The latest modification is not restored from backup project which can be opened from
"Project Recovery" dialog box.

Script Error may happen if "Handle Logical operations as Bit operations" on "Compatible"
tab in "Project Settings" dialog box is ON.

Even if "Handle Logical operations as Bit operations" on "Compatible" tab in "Project
Settings" dialog box is changed, the setting is not reflected to "Trigger Condition".

The selected Text color in "Format" tab is displayed as the Text color of Message



Switching Display instead of the Text color of "Msg0" when reopen the project.

In Message Switching Display, if "Use Text Manager" check box is ON and the parameter
of "Change" column is changed from "Y" to "blank", the entered message is deleted.

If "Windows" is selected as "Font" in property of Text, the following problems happen.

- If "Bold" is selected as "Style", it is changed to "Regular" after reopening the project.

- If "Bold Italic" is selected as "Style", it is changed to "Bold" after reopening the
project.

If two WindO/I-NV4s are launched and different Communication Drivers are assigned,
and then Multi Button, Multi Command or Script Command is copied and pasted each
other, Device Addresses in the script which is assigned to the object may be deleted.

If entered Tag Name or comment in Tag Editor contains vertical bar( | ), it is deleted.

In script or Trigger Condition, if used Device Address is Hexadecimal, MICRO/I access to
incorrect Device Address.

If Tag Editor is launched by clicking "..." button, and the entered Device Address is
Hexadecimal, incorrect Device Address is selected in Tag Editor.

Confirmation message for saving project is not displayed even if the project is changed
by the following operation.

- Use "Auto Resize"

- Use "Up", "Down" button in "Object List"

Change the value of "X"/"Y" on "Arrange" group in "Format" tab

Use "Delete" or "Reduce" button in "Script Manager"

- Use "Reuse Screen"

Change the name of base screen or popup screen on "Project" tab in "Workspace"

- Press "OK" button in "Screen Properties" dialog box when the screen is not

opened.("Screen Properties" dialog box can be opened from "Project” tab in

"Workspace")

Paste base screen or popup screen on "Project” tab in "Workspace"

- Add a new list in "Registration Monitor"

If "Save Auto Recover information every" is enabled, the following problems happen.

- The modification of the project is not reflected after downloading the project.

- Confirmation message for saving project is not displayed even if the project is
modified.

If Emerson ROC Protocol is selected and TLP type format is used as Device Address,

MICRO/I accesses to incorrect Device Address.

If "@" is used in Tag Name and the Tag Name is used in script, unexpected error

message is displayed.

If an existing project is opened, "Auto Resize" function does not work even if the "Auto

Resize" button is enabled.

Even if the property of Popup screen is changed, it may not be reflected to the dotted

rectangle which is displayed when "Popup Screen" on "Show/Hide" group in "View" tab is

ON.

The folder path which contains a dot character cannot be specified as "Default file

Location" on "Save" tab in "WindO/I-NV4 Options" dialog box

Even if the Device Address do not exist in the project, it can be set in part object after

Undo/Redo is executed.






WindO/I-NV4 Ver.1.0.1

<Runtime System Software>

Bugs Fixed

The following problems have been fixed:

4

4

When showing the system information of "HG2G-5TT22TF-*" using the WindO/I-NV4,
"HG2G-5TT22TF-*" is displayed on "Type Number" in the Target Information dialog box.
When SIEMENS S7-1200(Ethernet) Driver is selected, incorrect value may be written to
External Device Addresses if value is written in more than one External Device Addresses
at the same time.

When SIEMENS S7-1200(Ethernet) Driver is selected, value may be written to incorrect
External Device Addresses if the value is written in more than one External Device
Addresses at the same time by using script function. This happens if the External Device
Addresses are not sequential number.

<Application Software>

Bugs Fixed

The following problems have been fixed:

»

When Object List was floating, Drawing objects and Part objects were not selected even
if the listed objects in the Object List were selected.

The listed items in Tag Editor on Workspace are not the same as Tag Editor which is
called from "..." button when "Used Address Numbers" is selected as "Show" in Tag
Editor.

Incorrect information is displayed in Tag Editor on Workspace if "Used Address Numbers
is selected as "Show" in Tag Editor which is called from "..." button.

When you reopen and edit your project if you paste or duplicate parts, the address
number is added "1" regardless of the setting of "Increment Address".

The following 1 is not displayed proper position on MICRO/I if the project is downloaded
without opening the screen which contains 1 and 2.

1. Text Object in which "Center-Left" is selected as "Align Text Horizontal"
2. Any Buttons

Error message is displayed if any Device Addresses are not used in the formula for "Input
with Arithmetic Operation" or "Display with Arithmetic Operation" on "Options" tab in
"Numerical Input" or "Numerical Display" dialog box.

The state of the following check boxes on "Download" dialog box changes whenever you
download a project.

- Download Recipe Files to External Memory Device
- Download Picture Files to External Memory Device
The maximum value of Height and Width in the property of Drawing objects and Part



object is incorrect if "Vertical (Counter Clockwise)" or "Vertical (Clockwise)" selected as
"Installation”

» If "32-bit" is selected as "Data Type" in "Data Log Settings", the maximum value of
"Number of Stored Data for Data Log per Device Address" in "Data Storage Area
Management" dialog box is incorrect.

» If Emerson ROC Protocol is selected as Communication Driver, the Parameters which has
unsupported data type of TIME are shown on Tag Editor dialog box.

» If the following conditions are satisfied, the project cannot be opened properly.
"Windows" is selected as "Font" in Multi-State Lamp
- The project is created by WindO/I-NV2(*.n2g)



WindO/I-NV4 Ver.1.0.0

<Runtime System Software>
The following functions have been introduced.
» The HG2G-5T is now supported.

<Application Software>
The following functions have been introduced.

» Add functions and settings with supporting the runtime system software for HG2G-5T.
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